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About

Welcome to Ekran System!

Ekran System is an application that allows you to record the activity of the target computers with
installed Clients and to view the screen captures from these computers in the form of video.
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What's New

Ekran System v. 2.2 introduces the following changes:

Licensing process became easier and more user-friendly. Now, you have to purchase
serial keys and activate them via Internet. After this simple action, you’ll be able to
assign licenses to Clients for working with them. Offline activation is supported for
users that don’t have Internet on their Ekran System Server computer.

NOTE: If you already have the licensed Ekran System, you need to receive new serial
keys from your vendor and activate them.

The minimal screenshot color depth is 4 bit grayscale. Screenshots created with such
color depth require less space for storing (database size reduces by more than 20%)
without information value loss.

Windows 8.1 support is added.

The Ekran System Remote Clients installation wizard is changed to make Client
installation process more transparent and allow a user to avoid possible problems.

Ekran System Client and Ekran System Server logs are optimized. Out-dated logs are
automatically deleted. Ekran System Client work is less noticeable to the user.

Ekran System performance is improved. Ekran System Server and Viewer work quicker
now.

The help file format has been changed to PDF. Now, you can easily print a user
manual.

Overall stability is improved. Possible minor problems with processing large amounts
of data are fixed.
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System Requirements

Ekran System claims different system requirements for each of its components. Make sure your
hardware and software meet the Ekran System system requirements to avoid possible component
malfunctions.

Ekran System Server requirements:

e 2 GHz or higher CPU

e 1024Mb or more RAM

e 100 Mbit/s network adapter (1 Gbit/s is recommended)

¢ Microsoft Windows XP, Vista, 7 (any edition except Home), 8, 8.1; Windows Server 2003,
2008. Both x86 and x64 platforms are supported.

Ekran System Monitor requirements:
e 2 GHz or higher CPU

e 1024Mb or more RAM

e 100 Mbit/s network adapter

¢ Microsoft Windows XP, Vista, 7, 8, 8.1; Windows Server 2003, 2008 and newer. Both x86
and x64 platforms are supported.

Ekran System Client requirements:
e 1 GHz or higher CPU

e 512 Mb or more RAM

e 100 Mbit/s network adapter

¢ Microsoft Windows XP, Vista, 7, 8, 8.1; Windows Server 2003, 2008 and newer. Both x86
and x64 platforms are supported.

NOTE: When Ekran System Client is installed to the terminal server, hardware requirements
depend on the number of active user sessions and may increase drastically. For example,
hardware requirements for Ekran System Client deployed on the terminal server hosting 10
active user sessions will be as follows:

e Intel Core i3 or similar AMD CPU

e 2048 Mb RAM
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Program Structure

Program Structure

Ekran System is an application specially designed to control user activity remotely.

Ekran System includes the following components:

Ekran System Administrative Panel: Is the interface part of Ekran System Server used to
manage Ekran System system.

Ekran System Server: It is the main part of the Ekran System used for storing the screen
captures and associated information received from the Clients. The work of the Server can
be started or stopped via Server Tray.

Ekran System Monitor: This part of the Ekran System provides a usable interface for quick
review and analysis of the screen captures received from the Clients. The alert monitoring
function of the Monitor is accessible via Monitor Tray.

Ekran System Clients: Being hosted on the remote computers, Clients create screen
captures of the certain quality and the defined frequency and send them to the server.
Ekran System Administrative Panel features managing the remote Clients configurations
and settings.

Viewer 2

Viewer 1 @ Viewer 3

Server —_— @
/ Admin Panel
@ @
Client 1 @ Client 3

Client 2
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Server Tray

The Server Tray application informs you about the Ekran System state.

It also automatically restarts the Ekran System Server in case of its failure. The first three times
the restart is performed automatically. The user is informed about the Server failure in the
notification area. If the Server fails for the fourth time, it does not restart.

Hide Tray Icon

1
i
| ]
|
|

I |

You can start/stop Ekran System Server or hide the tray icon from the notification area.

If you want to contact the Support, you need to collect the Server log (Program Files\Ekran
System\Ekran System\Server\ServerService.log) and attach it to the request.

Monitor Tray

About Monitor Tray

Ekran System Monitor Tray is a special utility that notifies the investigator about the alert events
on the investigated computers. The alerts are displayed in the pop-up notifications from the
Windows tray area. The notifications may be set up to be displayed immediately or with a delayed
response in the Alert global settings accessible from the Administrative Panel.

Left-click on the tray icon opens the latest notification in the Monitor.

Ekran System Alert ‘é{

1 alert notification received.

View in the Ekran System Monitor

Right-click on the tray icon opens the context menu. It contains the following options:

Disable/Enable Tray Notification: Disables or enables the pop-up notifications from the Windows
tray.

Open Tray Notifications Journal: Opens the journal containing the records of the latest
notifications on alerts on the investigated computers.

Stop Ekran System Monitor Tray Service: Terminates the work of the utility.

10
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NOTE: To enable automatic launch of the Monitor Tray service at system startup, you need first
to log in to the Monitor at least once.

Disable Tray Notification

Open Tray Notifications Journal...

Stop Ekran System Monitor Tray Service

= o) -] el

Tray Notifications Journal

Tray Notifications Journal keeps the records of the latest alert notifications from the investigated
computers. The maximum number of the records in the Tray Notifications Journal is defined by
the investigator in the Alert global settings in the Ekran System Administrative Panel. When it is
reached, the oldest records are removed from the journal. The records can be cleared by clicking
the Empty Journal button.

NOTE: Information removed from the journal is not deleted from the database.
Information is displayed in the grid containing such columns:

e Alert: Displays the Alert name.

e Host: Displays the name of the computer on which the Alert event occurred.

e Time: Displays the time when the Alert event occurred on the investigated computer.

e Activity Title: Displays the name that appeared in the title of a window when the Alert
event occurred on the investigated computer.

o Application: Displays the name of the started application on the investigated computer
when the Alert event occurred on the investigated computer.

e Hyperlink: This column contains the link to the Alert screen capture in the Ekran System
Monitor. Left-click on it automatically launches the Monitor and takes the investigator to
the Alert screen capture.

Data in all columns can be sorted by clicking on the column header.

[=] Ekran System Tray Notifications Journal | = | = é
Aert Host Time /| Activity Title Application Hyperink
Facebook alert Aleks-A-PC 12.02.2013 9:11:09 Welcome to Facebook - ... firefox.exe View in the Ekran System .
Facebook alert Aleks-A-PC 12,02.2013 9:13:02 Welcome to Facebook - ... firefox.exe View in the Ekran System ..

Facebook alert Aleks-A-PC 12.02.2013 9:23:11 Ekran System Alert - Fac... EkranMonitor.exe View in the Ekran System ...
Aleks-A-PC 12.02.2013 9:31:59 Twitter - Moxzilla Firefox  firefox.exe

Empty Journal

11
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Deployment and Administration

About Program Installation

The Ekran System installation consists of several steps:

1. Installing the Ekran System Server and Administrative Panel: These components cannot be
installed separately. The Ekran System Server is used to store and process all records sent
by the Ekran System Clients hosted on the remote computers. The Ekran System
Administrative Panel is used to manage Ekran System users and alerts and configure
remote client settings.

2. Assigning Ekran System System Administrator and Supervisor: To start working with the
Ekran System, you have to assign Ekran System roles to Windows users.

3. |Installing Ekran System Clients: Ekran System Clients are usually installed remotely via the
Ekran System Administrative Panel. A Client can be installed on any computer in the
network. Ekran System Clients collect user activity data and send it to the Server.

4. Activating serial keys (adding activated serial keys): To be able to use Ekran System, you
need to license it by activating purchased serial keys.

5. Assigning licenses to Ekran System Clients: Licenses are to be assigned to Ekran System
Clients for the Ekran System to start receiving data from them. Clients that don't have an
assigned license do not collect any user activity data, even if they are installed and
launched on the computers.

6. Installing Ekran System Viewer: The Ekran System Viewer is used to review user activity
records stored on the Ekran System Server. The Viewer can be installed on any computer in
the network. A connection with the Ekran System Server is required for the Ekran System
Viewer to operate.

After installing all Ekran System components and assigning roles and licenses, Ekran System is
considered deployed and all its features become available.

Installing/uninstalling/updating Ekran System Server

Installing Ekran System Server and Administrative Panel

To install the Ekran System Administrative Panel, do the following:
1. Start the Ekran System setup wizard.
2. Click Next on the Welcome page.

12
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3. Carefully read the terms of the End-User Licence Agreement and click | Agree.
4. On the Choose Components page, do one of the following and click Next:

e Inthe drop-down list, select Server and Administrative Panel.
e Select Server and Administrative Panel in the box.

| 3 N
(=] Ekran System 2.0.0 Setup (BN

Choose Components

v

Choose which features of Ekran System 2.0.0 you want to install.

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select the type of install: [Ekran System Server & Administrative Panel v ]
Or, select the optional Ic]Eivan System Server & Administrative Panel ’
mt" you wish to [] Ekran System Monitor

Space required: 107.2MB

[<§ad< ][Next>][Cancd

5. On the Choose Install Location page, enter the installation path or click Browse to navigate

to the server installation folder. Click Next.

13



6. On the Database Type page, select the type of database you want to use for storing data.
Click Next.

.
=] Ekran System 2.0.0 Setup E‘;Ig

7.
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-
=] Ekran System 2.0.0 Setup E‘;Ig

Choose Install Location

Choose the folder in which to install Ekran System 2.0.0. <

Setup will install Ekran System 2.0.0 in the following folder. To install in a different folder, dick
Browse and select another folder. Click Next to continue.

Destination Folder
:\Program Files\Ekran System\Ekran System

Space required: 107.2MB
Space available: 220.1GB

Mullsoft Install System v2.46

[ < Back ][ Next > ][ Cancel

]

Database Type
Choose type of the database you want to use.

Database type:

(no third-party software required)

() MS SQL Server (installed MS SQL Server 2005/2008/2012
- required)

Mullsoft Install System ¥2.46

[ < Back ][ Next > ][ Cancel

)

If you have selected MS SQL Server, on the MS SQL Server Database Configuration page,
define the connection parameters and then click Next.

14
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8. Define the MS SQL Sever instance name, which is the instance name assigned to the TCP/IP
port.

o Define the Database name for Ekran database.

e Define the User name and Password of a user account via which the connection to the
Server will be established.

r T
Ekran System 2.0.0 Setup =N X

MS SQL Server Database Configuration
Configure the connection to MS SQL Server and database.

Server instance:
Database name: EkranActivityDB

User name:

Password:

< Back ][ Next = ] [ Cancel

A

9. On the Database Location page, enter the database path or click Browse to navigate to the
database installation folder. Click Next.

15
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Vv | N
=) Ekran System 2.0.0 Setup L] o
Database Location :
Choose the folder in which database will be installed. s
Database folder:

C:\ProgramData\Ekran System\Ekran System

A

10. On the Choose Start Menu Folder page, define the name of the folder in the start menu to
which the shortcuts will be placed. Click Install.

11. Installation starts.
12. After the installation finishes, click Finish.

13. In Windows Firewall, you must allow Ekran System Server executable to accept TCP
connections via ports 9446, 9447, 9449. These rules will be added to Windows Firewall
automatically, if Windows Firewall is enabled during Ekran System Server installation.

Adding Server Executable to Windows Firewall

To add Ekran System Server executable to the Windows Firewall:
1. Select Start > Control Panel > System and Security > Windows Firewall.
2. The Windows Firewall window opens.

16
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ESIER=X)

@uv|ﬂ' + Control Panel » Systern and Secunty » Windows Firewall

- |4f | | Search Control ... |

@J Advanced settings

Troubleshoot my network

See also
Action Center
Metwork and Sharing Center

. r@ Home or work (private) networks

. r@] Public networks

Control Panel Home . . . @
Help protect your computer with Windows Firewall
Allow a program o feature Windows Firewall can help prevent hackers or malicious software from gaining access to your
through Windows Firewall computer through the Internet or a network.
@ Change notification settings How does a firewall help protect my computer?
'@' Turn Windows Firewall on or What are network locations?
off = —
/1 : ()
@ Restore defaults . @ Domain networks Mot Connected (v

Connected V

Mot Connected V

3. Click Advanced settings. The Windows Firewall with Advanced Security window opens.

4. Right click Inbound Rules and select New rule.

@ Windows Firewall with Advanced Security

File Action WView Help

&« | 2E = BHE

- !
S Connectil b Profile

. B Monitorir
Filter bry State

Filter by Group
View

Refresh

Export List...

Help

ENMVEr EXE
ft Office Outlook
ermanent protection
ermanent protection
p HTML

p HTML

mrmander 32 bit
mmander 32 bit

[T Total Commander 32 bit

@ Windows Firewall with Advance Bl

g Inbound Bude-] I
| Mew Rule Gr
Cutboun

5. The New Inbound Rule Wizard opens. On the Rule Type step, select Program and click Next.

17
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g# Mew Inbound Rule Wizard

==

L

Rule Type
Select the type of firewall rule to create.

Steps:

Rule Type
Program
Action
Profile

Mame

What type of rule would you lilke to create?

@ Program

Fule that controls connections for a program.

' Port

Rule that controls connections for a TCP or UDP port.

' Predefined:

BranchCache - Content Retrieval (Uses HTTF)
Fule that controls connections for a Windows experience.

7 Custom
Custom rule.

Leam more sbout nule types

6. On the Program step, select This program path, then click Browse and navigate to the Ekran
System Server executable. The default path is "C:\Program Files\Ekran System\Ekran
System\Server\EkranServer.exe". Click Next.

18
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=

g# Mew Inbound Rule Wizard

Program
Specify the full program path and executable name of the program that this rule matches.

Steps:

@ Rule Type Does this rule apply to all programs or a specific program?

& Program

@ Action ) All programs

@ Profile Rule applies to all connections an the computer that match other nule properties.
@ Mame

@ This program path:

Browse...

Example: c:\path program exe
% ProgramFiles . \browserbrowser exe

Leam more sbout specifying programs

<Back || Ned> || Cancel

7. On the Action step, select Allow the connection and then click Next.

19
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g# Mew Inbound Rule Wizard

25|

Action

Steps:

Rule Type
Program
Action
Profile

Mame

Specify the action to be taken when a connection matches the conditions specified in the rule.

What action should be takeen when a connection matches the specified conditions?
@ Allow the connection
This includes connections that are protected with IPsec as well as those are not.
7 Allow the connection if it is secure
This includes only connections that have been authenticated by using IPsec. Connections

will be secured using the settings in IPsec properties and rules in the Connection Security
Rule node.

7 Block the connection

Leam more sbout actions

<Back || Ned> || Cancel

8. On the Profile step, select the profile of the network used for connecting remote computers
and the Ekran System Server. Click Next.

20
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g Mew Inbound Rule Wizard ﬁ

Profile
Specify the profiles for which this rule applies.

Steps:

# Fuls Type When does this rule apphy™

& Proaram

@ Acticn Domain

& Profile Applies when a computer is connected to its comporate domain.
@ Mame ["] Private

Applies when a computer is connected to a private network location.

[”] Public
Applies when a computer is connected to a public networ: location.

Leam more sbout profiles

9. On the Name step, define the Name of the rule. Click Finish.

21
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& 2 ~
ﬂ New Inbound Rule Wizard @

Name

Specify the name and description of this rule.

Steps:
@ Rule Type
@ Program

@ Action
Name:
Ekran|

& Profile

@ Name

Description (optional):

10. The rule is created for the Ekran System Server application. By default, the rule allows any
connections via all ports.

11. To define the protocol and ports, double click the Ekran System (the name you defined in the
previous step) rule in the list in the Windows Firewall with Advanced Security window. The
Ekran System Properties window opens.

22
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Ekran Properties

==

Computers

Advanced

Users

l General l Programs and Services
Protocols and Ports | Scope
Protocols and ports
s’ Protocol type: |TcP
Protocol number: 6L
Local port: [Specific Ports
9446, 9447, 9449
Example: 80, 443, 5000-5010
Remote port: [A!l Ports

o)

Intemet Control Message Protocol
{(ICMP) settings:

Leam more about protocol and ports

Example: 80, 443, 5000-5010

R G

| | Cancel ||

Apply |

12. In the Protocols and Ports tab, do the following:

¢ Inthe Protocol Type list, select TCP.

¢ Inthe Local port list, select Specific Ports. Type the port numbers (9446, 9447, 9449)

in the box below.

NOTE: These rules will be added to Windows Firewall automatically, if Windows
Firewall is enabled during Desktop Surveillance Server installation. If you use any
other Firewall, these ports and executable must be added to it as well.

13. Click Apply to save changes. Click OK to close the window.

14. Close the Windows Firewall window.

NOTE: Unique external IP addresses should be used for cloud-based servers.
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Database Types Comparison

When installing Ekran System Server and Administrative Panel, you can choose between the two
types of databases (MS SQL database and Firebird database). These databases have the following
differences:

Feature MS sQL Firebird Database
Database

Free No (has a limited Yes
free version)

Processing High Low

speed

Remote Yes No

access to

database

Requires Yes No

additional

software

installation

Security High Low

N

Updating Ekran System Server

The updating of the Ekan System Server is performed via the Ekran System installation file of a
newer version. During an update you may select to update the existing database to a newer
version or simply reinstall it.

To update the Ekran System Server, do the following:

Start the Ekran System setup wizard.
On the Welcome page, click Next.
On the Already Installed page, select Update/Add/Remove components and click Next.
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[=] Ekran System 2.4.1435 Setup Lo et

Already Installed
v

Choose how you want to install,

The Ekran System Ekran System of the older version 2.3, 1435 is already installed. Select the
operation you want to perform and dick Mext to continue.

@ Update/add/Remove companents

< Back ][ Mext = ] [ Cancel

)

4. On the Choose Components page, select Ekran System Server & Administrative Panel and click

Next.

[=] Ekran System 2.4.1435 Setup Lo et

Choose Components
Choose which features of Ekran System 2.4, 1435 you want to install, w©

Chedk the components you want to install and uncheck the components you don't want to
install. Click Mext to continue.

Select the type of install: [Ekran System Server & Administrative Panel -

Or, select the optional Ekran System Server & Administrative Panel (update to

companents you wish to _
install: [ ] Ekran System Monitor

Space reguired: 131, 1ME

4 L} | 3

[ < Back ][ Mext = ] [ Cancel

)

NOTE: If you have Ekran System Monitor installed on the same computer, you will need to select
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to update it as well, otherwise it will be removed.

On the Database Update page, if you want to keep the existing database, select Update database
to a new version, otherwise select Reinstall the database. Click Next.

=] Ekran System 2.4.1435 Setup R
Database Update
Select either to update the database to a new version or to reinstall it

5 |Ipdate the database to a new version (the database type can't be
chanaed)

WARMING: If you use the M5 SOL database, it's strictly recommended to
backup it before updating.

Reinstall the database (all data will be lost)

| = Back H Mext = ] | Cancel

NOTE: To change the type of a database, you need to reinstall the Ekran System.

The update process starts.
If the update process finishes successfully, you will see the last page of the wizard. Click Finish to

exit the wizard.

Uninstalling Ekran System Server

Uninstalling Ekran System Server causes installed Ekran System Administrative Panel to be
removed from the current computer as well. The Ekran System database containing all the user
activity records is removed too. This operation is irreversible.

Warning! During Ekran System Server uninstallation, the database is removed without any user
confirmations.

NOTE: If you reinstall the Server and there are serial keys activated online, you need to have an
active Internet connection after the Server is reinstalled to synchronize the activated serial keys.
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If you have added activated serial keys, after the Server is reinstalled, you need to add them
again.

To uninstall the Ekran System Server from the local computer:

NOTE: Before uninstalling the Ekran System Server, make sure you have removed all Ekran
System Clients from the remote computers. If you don't remove the Clients, they will remain
installed on the remote computers and it will be impossible to remove them in a common way.

Start the Ekran System setup wizard by launching the setup executable (e.g. EkranSystem-
1.1.12_en.exe) or clicking Uninstall/Change on the Ekran System application in the Programs
and Features window of the Windows Control Panel.

The setup wizard opens.
Click Next on the Welcome page.
The Already Installed page opens. Select Uninstall and click Next.

[ (=) Ekran System 2.0.0 Setup E=E )

Already Installed
Choose the maintenance option to perform.

Ekran System Ekran System 2.0.0 is already installed. Select the operation you want to
perform and dick Next to continue.

() Uninstall

[ < Back H Next > ] [ Cancel

5. The Uninstall Ekran System page opens. Click Uninstall.
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Ekran System 2.0.0 will be uninstalled from the following folder. Click Uninstall to start the
uninstallation.

Uninstalling from: C:\Program Files\Ekran System\Ekran System)

[ Uninstall ] [ Cancel

= B
&) Ekran System 2.0.0 Uninstall = | Ii&l
Uninstall Ekran System 2.0.0 —
Remove Ekran System 2.0.0 from your computer. Il €

Wait for the uninstallation process to complete. The wizard final page opens.

leanli=hl

-
Ekran System 2.0.0 Setup

Completing the Ekran System 2.0.0
Setup Wizard
Your computer must be restarted in order to complete the

installation of Ekran System 2.0.0. Do you want to reboot
now?

) I want to manually reboot later

< Back [E

28



7.

N

P w

Deployment and administration

Make a selection to reboot your computer automatically now or manually later and click
Finish.

Installing/uninstalling/updating Ekran System
Monitor

Installing Ekran System Monitor

The Ekran System Monitor is used to investigate the user activity by viewing the screen captures
created by the Ekran System Clients and then sent to and stored on the Ekran System Server
database.

The Ekran System Monitor can be installed on any computer, but a network connection to the
Ekran System Server is required for the Monitor to operate.

To install the Ekran System Monitor, do the following:
Start the Ekran System setup wizard.

On the Welcome page, click Next.

NOTE: If you have any other Ekran System components installed on this computer, the
setup wizard will offer to add or remove components and the installation procedure will
differ a bit.

Carefully read the terms of the End-User Licence Agreement and click | Agree.
On the Choose Components page, do one of the following and click Next:

e Inthe drop-down list, select Monitor.

e Select Monitor in the box.
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=3 Ekran System 200 Setup (=] -t

Choose Components
Choose which features of Ekran System 2.0.0 you want to install. ©
Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.
Select the type of install: [Ekran System Monitor v
Or, select the optional [ Ekran System Server & Administrative Panel
mf"e"" you wish to Ekran System Monitor

Space required: 12.3MB

[ <gack [ Next> | [ cancel |

5. Do one of the following to define the destination folder for the application and click Next:
e Click Browse and in the Browse For Folder window, define the destination folder.
e Enter the destination folder in the corresponding field.

f 1
= Ekran System 2.0.0 Setup o

Choose Install Location
Choose the folder in which to install Ekran System 2.0.0.

Setup will install Ekran System 2.0.0 in the following folder. To install in a different folder, click
Browse and select another folder. Click Next to continue.

Destination Folder
:\Program Files\Ekran System\Ekran System

Space required: 12.3MB
Space available: 220.1GB

Nullsoft Install System v2.46

| <Back || nNext> | [ cancel |

6. On the Choose Start Menu Folder page, do one of the following and click Install:
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e Define the name for the program folder in the Start Menu.
e Select Do not create shortcuts to not create the program shortcuts.
7. The process of installation starts. Its progress is displayed on the Installing page.
8. If the installation finishes successfully, you will see the last page of the wizard. Click Finish to
exit the wizard.

Updating the Ekran System Monitor

The updating of the Ekan System Monitor is performed via the Ekran System installation file of a
newer version.

To update the Ekran System Monitor, do the following:

1. Start the Ekran System setup wizard.
On the Welcome page, click Next.
3. On the Already Installed page, select Update/Add/Remove components and click Next.

N

[ (] Ekran System 2.4.1435 Setup R

Already Installed
Choose how you want to install,

The Ekran System Ekran System of the older version 2.3, 1435 is already installed. Select the
operation you want to perform and dick Next to continue.

@ Update/Add/Remove compaonents

| = Back H Mext = ] | Cancel |

NOTE: If you have Ekran System Server and Administrative Panel installed on the same
computer, you will need to select to update them as well, otherwise they will be removed.

4. On the Choose Components page, select Ekran System Monitor and click Next.

31



Deployment and administration

[=] Ekran System 24,1435 Setup N
Choose Components
Choose which features of Ekran System 2.4, 1435 you want to install, |

Chedk the components you want to install and uncheck the components you don't want to
install. Click Mext to continue.

Select the type of install: [Hcran System Monitor "]

Or, select the optional [ ] Ekran System Server & Administrative Panel

components you wish b Ekran System Monitor (update to 2.4.1435)

Space reguired: 19.0MB

< Back ][ Mext = ] [ Cancel

The update process starts.

If the update process finishes successfully, you will see the last page of the wizard. Click Finish to
exit the wizard.

Uninstalling Ekran System Monitor

Uninstallation of the Ekran System Monitor can be performed in 2 ways:

e Viathe Ekran System setup wizard by choosing Add/Remove components: This method
should be used when Ekran System Monitor is installed together with any other Ekran
System components.

e Through Programs and Components in the Windows Control Panel: If you want to remove
only Monitor application, use this method only when no other components are installed
on the computer along with Ekran System Monitor. This method is intended to remove all
Ekran System components installed on the current PC.

To uninstall the Monitor that is installed along with the Ekran System Server and/or Client:
Run the Ekran System setup package (e.g. EkranSystem-1.1.12_en.exe).

Click Next on the Welcome page.

On the Already Installed page, select Add/Remove components and click Next.
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-
=) Ekran System 2.0.0 Setup sl

Already Installed
Choose the maintenance option to perform.

Ekran System Ekran System 2.0.0 is already installed. Select the operation you want to
perform and dick Next to continue.

() Uninstall

Mullsoft Install System v2.46

| <Back || Next> | [ cancel |

4. The Choose Components page opens. Clear the Monitor check box and click Next.

r r
E=] Ekran System 2.0.0 Setup o[-l

Choose Components
Choose which features of Ekran System 2.0.0 you want to install. <«

Check the components you want to install and uncheck the components you don't want to
install. Click Next to continue.

Select the type of instal: | Custom v

Or, select the optional Ekran System Server & Administrative Panel
corponens youwih | YRR

Space required: 124.2MB

[<aad<][Next>][Canod

5. The setup wizard removes the unselected components.
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6. When uninstallation is complete, click Finish.

To uninstall the Monitor that is installed alone on a separate computer:
Open the Windows Control Panel and navigate to the Programs and Components page.
Select Ekran System in the programs list and click Uninstall/Change on the toolbar.

@Uv] <« Programs » Programs and Features v ’ +5 ‘ [ Search Programs and Features pe, ‘
Contrel Panel Home .
Uninstall or change a program
View installed updates To uninstall a program, select it from the list and then click Uninstall, Change, or
"’:ﬂ Turn Windows features on or Repair.
off
Install a program from the Organize v  Uninstall/Change SEE -@
network -
Name Publisher 2
% AvG 2011 AVG Technologies ]
M AVG Security Toolbar AVG Technologies E
(=] Ekran System 2.0.0 Ekran System
[ Ekran System Client 2.0.0 Ekran System
(27 EVEREST Ultimate Edition v4.20 Lavalys, Inc.
(51 GUI Design Studio 3.4.92.0 Caretta Software Ltd -
<[5 m J »
. "|' Ekran System Product version: 2.0.0

3. The Uninstall Ekran System page opens. Click Uninstall.

34



Deployment and administration

K= T ~
&) Ekran System 2.0.0 Uninstall = | I&J
Uninstall Ekran System 2.0.0 ,
Remove Ekran System 2.0.0 from your computer. l €
Ekran System 2.0.0 will be uninstalled from the following folder. Click Uninstall to start the
uninstallation.

Uninstalling from: C:\Program Files\Ekran System\Ekran System)

l Uninstall ] [ Cancel

4. Wait for the setup wizard to complete uninstallation and click Finish.

Installing/uninstalling/updating Ekran System
Clients

About Client Installation

During Ekran System deployment, remote installation of Ekran System Clients is used. Remote
installation of Ekran System Clients is performed via Administrative Panel.

To ensure successful remote installation of Ekran System Clients, you have to set up the network
environment beforehand. If your computers belong to a workgroup but not a domain, you need
to know the administrator account credentials for each remote computer. Otherwise knowing the
Domain Administrator credentials is enough.

Ekran System also features installing Clients (either local or remote) via the installation package
generated in the Administrative Panel. Thus you can distribute the installation package of the
Client with predefined settings among the network computers and install it. This kind of
installation is useful when you experience difficulties with installing Ekran System Clients remotely
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via Administrative Panel, or the computers in your network are part of a workgroup and do not
have the same administrative account for each computer.

NOTE: It is possible to install the Ekran System Client locally via setup wizard. But the Ekran
System Client installed this way is only capable of interacting with the local Ekran System
Server. Use other installation methods instead.

Client Installation Prerequisites

Setting up Environment for Remote Installation

You might need to make changes to your network configuration for successful Ekran System
installation, and for its components normal interaction.

The majority of Clients installation/uninstallation issues are caused by incorrect system or
network settings.

The following conditions have to be met for successful Ekran System Client installation:
e The remote computer has to be online and accessible via network.

e Shared folders have to be accessible on the remote computer. Simple file sharing (Sharing
Wizard) has to be disabled.

¢ You need to know the domain administrator or local administrator account credentials for
the remote computer.

e The Server and the Remote Procedure Call (RPC) system services have to be running on the
remote computer.

e Windows XP and Vista Firewall has to be disabled on the remote computer during the
Clients remote installation.

e In Windows 7 and Server 2008 Firewall, allow inbound connections in the Remote Service
Management (RPC) rule for the remote computers (in this case it is not necessary to
disable Windows Firewall)

e In Windows Firewall on the Server side, allow Ekran System Server executable to accept
TCP connections via ports 9446, 9447, 9449:

NOTE: These rules will be added to Windows Firewall automatically, if Windows Firewall is
enabled during Ekran System Server installation.

Make sure the conditions mentioned above are met to avoid possible problems with Client
remote installation.

Disabling Simple File Sharing in Windows XP
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To disable Simple file sharing in Windows XP, do the following:

Open My Computer.
Select Tools > Folder Options in the menu.
The Folder Options window opens. Select the View tab.

Folder Options -\

Gereral | ¥iew | File Types | Qfffine Files

-~

Faolder wigws

Y'ou can apply the view [zuch az Detailz or Tiles] that
wou are wzing for thig folder to all folders.

[ Apply to All Folders ] [ Beszet All Folders

Advanced zethings:

) Do not show hidden files and folders A
(*) Show hidden files and folders

[] Hide extensionz for known fle types

[] Hide protected operating system files [ ecommended)

[1 Launch folder windows in a separate process

[ ] Remember each folder's view settings

[ ] Restore previous folder windows at logon

[1 Show Control Panel in My Computer

Show encrepted or compressed MTFS files in color

Show pop-up description faor folder and desktop items

[ ] iUse simple file sharing [Recommended) | il
< >

[ Rezstore Defaults ]

[ 0k, H Cancel H Apply ]

Clear the Use simple file sharing check box.
Click Apply and OK to close the window.

Disabling Sharing Wizard in Windows 7

To disable the Sharing wizard in Windows 7, do the following:
Open Computer.

Select Organize > Folder and search options.

The Folder Options window opens. Select the View tab.
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o

Folder Cptions ﬁ
View | Search

Folder views

You can apply the view (such as Details or lcons) that
you are using for this falder to all folders of this type.

[ Apply to Folders ] [ Reset Folders

Advanced settings:

[] Launch folder windows in a separate process -
[] Restore previous folder windows at logon
Show drive letters
Show encrypted or compressed NTFS files in color
Show pop-up description for folder and desktop tems
Show preview handlers in preview pane
[] Use check boxes to select items
B

When typing into list view

(7 Automatically type into the Search Box

@ Select the typed tem in the view

m

1

[ Restore Defaults ]

| ok || cance || poly |

Clear the Use Sharing Wizard check box.
Click Apply and OK to close the window.

Checking System Services

To check that the Server and Remote Procedure Call (RPC) system services are running:
Right click Computer and select Manage. Computer Management opens.
Expand the Services and Applications node and select Services.

Find the Server service and the Remote Procedure Call (RPC) service in the list of services.
Make sure both services are running (they status is displayed as Started).
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P

(A Computer Management

File  Action View Help

e 2B o BE) > =0

A Computer Management (Local
Fi '[[’U!- System Tools
» @ Task Scheduler
- §2] Event Viewer
» a2 Shared Folders
» &% Local Users and Groups
» u@f; Performance
i=y Device Manager
a4 =5 Storage
(=5 Disk Management

4 Ty Services and Applications
T Services
& WMI Control
> % 5QL Server Configuratic
4 m r

~

Mame

o Remote Desktop Services UserMode ...

% Remote Procedure Call (RPC)
" Remote Procedure Call (RPC) Locator
% Remote Registry

% Routing and Remote Access
5 RPC Endpoint Mapper
o secondary Logon

S Secure Socket Tunneling Protocol Se...

o Security Accounts Manager
o Security Center

]

< |

SErver
Shell Hardware Detection
Skype Updater

Description

Allows the ...

The RPCS55 =...
In Windows ...

Enables rem...

Offers routi...

Resobves RP...

Enables start...

Provides zu...
The startup ...
The WSCSV..,

Supports file...

Provides not...

Enables the ...

Status

Started

Started

Started
Started
Started
Started

Startup Type
Manual
Automatic
Manual
Manual
Disabled
Automatic
Manual
Manual
Automatic
Automatic (D,
Automatic
Automatic

Automatic

T

Extended ;\Standard /

If one or both services are not running, start them manually. To start the service, right click it
and select Start from the context menu. The selected service is started.

To quickly access Windows Services, press Windows+R, type services.msc in the Run text box and

press Enter.

To disable Windows XP Firewall:
1. Select Start > Control Panel > Windows Firewall.

Disabling Windows XP/Vista Firewall

2. The Windows Firewall window opens.
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& Windows Firewall

General | Exceptions | Advanced

“'our PC iz not protected: turn on Y indowves Firewall

Windowes Firewall helps pratect your computer by preventing unauthonized users
from gaining access to your computer through the Intermet or a nebwork.

@ () On [recommended]

Thiz zetting blocks all outzide zources from connecting to this
computer, with the exception of thoze selected on the Exceptions tab.

Select thiz when pou connect to public nebworks in lezs secure
lozationz, such as airportz. v'ou will not be notified when 'Windows
Firewwall blocks programs. Selections on the Exceplions tab will be
igriored.

@ (*)!0ff [not recommended}

Ayoid uzing thiz zetting. Turming off Windows Firewall may make thiz
computer more wulnerable to viruzes and intruders.

What elze should | know about Yindows Firewall?

[ 1]8 l [ Cancel

3. Select Off (not recommended) and click OK.

To disable Windows Vista Firewall:
1. Select Start > Control Panel > Security > Windows Firewall.

2. Click Turn Windows Firewall on or off. Enter your administrator password if prompted to do
so.
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-

y Turn Wi ; Firewall on or

Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your

SpEaEnhEak computer through the Internet or network.

rs Firewall
Heow dees a firewall help pretect my computer?

@ Windows Firewall is helping to protect your computer

Windows Firewall is on. '@ Change settings
i Windows Firewall Settings ﬁ

General |E}c::epﬁons | Advancedl

Windows Frrewal is helping to protect your computer

Windows Firewall can help prevent hackers or malicious software from gaining
access to your computer through the Internet or a network,

L@ ) On (recommended)

This setting blocks all outside sources from connecting to this
computer, except for those unblodked on the Exceptions tab.
Block all incoming connections
Select this option when you connect to less secure netwarks. All

exceptions will be ignored and you wil not be notified when
Windows Firewall blocks programs.

|@ @ Off (not recommended)

Avoid using this setting. Turning off Windows Firewall will make this
computer mare vulnerable to hadkers or malicdous software.

— Tell me more about these settings

[ ok || cancel || spoly |

3. Inthe Windows Firewall Settings window, select Off (not recommended) and click OK.

Setting Up Windows 7 Firewall

It is not necessary to disable the Windows Firewall in Windows 7 and Windows Server 2008. For
successful remote installation of Ekran System Clients, you have to allow inbound connections in
the Remote Service Management (RPC) rule for the remote computers.

To enable inbound connections for the Remote Management Service (RPC), do the following:
1. Select Start > Control Panel > System and Security > Windows Firewall.
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2. The Windows Firewall window opens.
[ ESRER=X)
@'\’_}"ﬂ » Control Panel » Systern and Secunty » Windows Firewall - |4f | | Search Control P... O |

@

Control Panel H . . .
e Help protect your computer with Windows Firewall

Allow a program or feature Windows Firewall can help prevent hackers or malicious software frem gaining access to your

through Windows Firewall computer through the Internet or a network.
@ Change notification settings How does a firewall help protect my computer?
'@' Turn Windows Firewall on or What are network locations?
off .
[.- - |'._.'|
B Restore defaults . @ Domain networks Mot Connected (v
'@ Advanced settings i . P
@ Home or work (private) networks Connected (v)
Troubleshoot my network
. [@ Public networks Mot Connected (v)

See also
Action Center
Metwork and Sharing Center

3. Click Advanced settings. The Windows Firewall with Advanced Security window opens.

4. Click Inbound Rules and then double click the Remote Service Management (RPC) rule in the
rules list.

F A
@ Windows Firewall with Advanced Security @M

File  Action View Help

9| 7E) = H
g Windows Firewall with A BETEet v LT e Actions
&3 Inbound Rules Name Group 4 = || inbound Rules o -
Outbound Rules
By Connection Security .Remote Scheduled Tasks Management (... Remote Scheduled Tasks M., il MewRule..
- Bl Monitoring .F‘.emote Service Management (MP-In) Remote Service Managemen T Filter by Profile »
. Remote Service Management (MP-In) Remnaote Service Managemen .
. . SF Filter by State 4
. Remote Service Management (RPC) Remote Service Managemen
. Remote Service Management (RPC) Remote Service Manageme Y Filter by Group 4 !
.F‘.emote Service Management (RPC-EPM... Remote Service Managemen View » 3
.Remote Service Management (RPC-EPM... Remote Service Managemen
. & Refresh
.F‘.emote Volume Management - Virtual D... Remote Volume Manageme,
@ Remote Volume Management - Virtual D... Remote Volume Manageme, =) Export List...
.Remote‘u’olume Management - Virtual D... Remote Volume Manageme.|j E Help
.Remote\u’olume Management - Virtual 0. Remote Volume Manageme, 4

Remote Service Management (RP... &

.Remote‘u’olumeManagement(RPC—EPM... Remote Volume Manageme.
.RemoteVolumeManagement(RPC—EPM... Remote Volure Manageme, iJ Enable Rule

.F‘.outing and Remote Access (GRE-In) Routing and Remote Access = # Cut
< [ K 11 3

s
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5. The Remote Service Management (RPC) Properties window opens.

{D This is a predefined rule and some of its properties cannot
be modified.

General
Sl MName:
Remote Service Management (RPC)
Description:

Inbound rule for the local Service Cortrol Managertobe -
remotely managed via RPC/TCP.

Enabled

Action
=5 @ Alow the connection

v e
@ 0 Allow the connection if it is secure

(71 Block the connection

Leam more about these settings

Remote Service Management (RPC) Properties ﬁ
| Protocols and Ports | Scope | Advanced I |sers
General | Programs and Services I Computers

[ oK || Cancel || pply

)
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In the General tab, select Enabled under General and click Allow the connection under

Action.

In the Advanced tab, under Profiles, select the profile of the network used for connecting

remote computers and the Ekran System Server.
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Remocte Service Management (RPC) Properties @
General | Programs and Services | Computers
Frotocols and Ports | Scope | Advanced | Lzers
Profiles

h Specify profiles to which this rule applies.

ﬂl’
= Diomain

Private
Public
Irterface types
I Specify the interface types to which this
| rule applies. =
Edge traversal

Edge traversal allows the computer to accept unsolicited

"=  inbound packets that have passed through an edge device
such as a Metwork Address Translation (MAT) router or
firewsall.

Block edge traversal v]

Prevent applications from receiving unsolicited traffic from
the Intemet through a MAT edge device.

Leam maore about these settings

OK || cancel || Apply |

8. Click Apply and then OK to save the settings and close the Properties window.
9. Close the Windows Firewall window.
10. Create an inbound rule for Server executable.

Installing Clients via Administrative Panel

To perform the remote Client installation via Ekran System Administrative Panel, do the
following:

1. Start the Ekran System Administrative Panel.
2. Select Ekran System Clients in the navigation pane or details pane.

3. Click Action and select Install Ekran System Client or right-click and select Install Ekran
System Client.
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-
@ Ekran System Administrative Panel | = ‘ = &I
(=] File Action View Window Help - [[&] %
es|E o= HE
E=] Ekran System Ekran System
; \"“ Roles B Roles
w Alerts [N
x o Alerts
A Ekrag Swstem Clients | [ e 5 Ci
Install Ekran System Client... Iy eI
Uninstall Ekran System Clients...
Manage Licenses...
Refresh
New Window from Here
Help
Install client
[

4. The Ekran System Client Installation Wizard opens. Click Next on the Welcome page.
5. On the Ekran System Client Package Mode page, select one of two options and click Next:

e Create Ekran System Client package: Use this option if you haven't performed a
remote installation yet. Type the path to the newly created package or click Browse

and navigate to it.

e Select Ekran System Client package: Use this option if you have performed a remote

installation already. Type the path to the installation package or click Browse and navigate
toit.

NOTE: If you select the Select Ekran System Client package option, steps 6,7,8 will be
omitted.
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-

Ekran System Client Installation Wizard

[

Ekran System Client Package Mode
Define dient installation package location

@ Create Ekran System Client packai

(©) Select Ekran System Client packac

WC:\Program Files\Ekran System\Ekran System\Administratc

Browse...

[ <gak J[ Next> | [ cancel |

6. On the Screen capture color settings page, select the color depth for the created screen

captures and click Next.

-
Ekran System Client Installation Wizard

Screen capture color settings
Define color depth of Client screen captures

Bit depth:

| <Back || Next> | [ cancel |

7. On the Screen capture creation settings page, define the frequency with which the screen

captures will be created. Click Next.
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Ekran System Client Installation Wizard

Ekran System Client Settings
Define events, on which screenshots will be captured from Client display, and
necessity of keystrokes investigation

Create screenshots on the following events:

[V]iCapture screen periodically:

Period in sec: 30 =

Capture screen on active window change
P ng
[7] check changing of names of windows

Capture screen on dicking and key pressing

Enable keystrokes logging

[ < Back ][ Next > ][ Cancel

]
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8. On the Server Name page, type the name or the IP-address of the computer on which the
Ekran System Server and Administrative Panel are installed. Clients will connect to this server
and the received screen captures will be stored on its computer. Click Next.

7

Ekran System Client Installation Wizard

=28

Server Name
Enter the name of the computer with installed Ekran System Server to which o

Ekran System Clients will connect.

Name of the computer on which server is installed:

bicks 2.5

[ <Back || mext> | [ cancel
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Note: The server IP address has to be static for Clients to connect to it successfully. Unique
external IP addresses should be used for cloud-based servers.

On the Further Actions page, check the location to which the installation package will be

saved and select the | want to install the configured Client automatically on remote

computers option. Click Next.

10. On the Remote Installation page, read the information that will help you to install Clients on
remote computers successfully and make sure that all conditions are met on computers on
which Clients are to be installed. Click Next.

11. On the Add computers page, select hosts on which Clients are to be installed. Click Next.

7

Ekran System Client Installation Wizard

(e

Add computers
Select computers on which Clients will be installed.

Network: Selected computers:
Name Workaroup = Name Workgroup
KENNY DEV LIZARD DEV
KEY DEV
KOMARQVSER] DEV
KOTOVSKY DEV
KRIVORUCHKO DEV
KSB2 DEV
LEGA1 DEV
LENOVO DEV
LIGEN-MAIN DEV
LIGHTMOON  DEV =
( Advanced... 1
< Back ][ Next = ][ Cancel ]

12. On the Authentication page, enter the administrator credentials under which the Clients are

to be installed and then click Next:

If the computers are in a domain, enter the domain name and domain Administrator
account credentials.

If the computers are in workgroup, leave the Domain box empty and enter the
credentials of a local Administrator for target computers.

NOTE: All workgroup computers must have the same Administrator account
credentials. Otherwise use installation via installation package method to deploy Ekran

System Clients.
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g B
Ekran System Client Installation Wizard l-cx’-J
Authentication ;
Enter user credentials for Client installation. \ %
User login:

User password:

Package creation starts. As soon as the package is created, it is deployed on the selected host
computers and the Client is installed on them.

Wait for the wizard to complete the installation and click Finish.

Installing Clients via Installation Package

You can install Ekran System Clients via the installation package in 2 ways:
e via the administrative panel using the formerly created package

e by copying the package to the remote computer and starting it there.

To create an installation package:

NOTE: Steps are the same as steps 5-9 of the remote Client installation instructions.

Start the Ekran System Administrative Panel.
Select Ekran System Clients in the navigation pane or details pane.

Click Action and select Install Ekran System Client or right-click and select Install Ekran
System Client.

The Ekran System Client Installation Wizard opens. Click Next on the Welcome page.
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On the Ekran System Client Package Mode page, select Create Ekran System Client package
and click Browse to select a folder to which it will be saved, and then click Next.

On the Screen capture color settings page, select the color depth for the created screen
captures and click Next.

On the Screen capture creation settings page, define the frequency with which the screen
captures will be created. Click Next.

On the Server Name page, type the name or the IP-address of the computer on which the
Ekran System Server and Administrative Panel are installed. Clients will connect to this server
and the received screen captures will be stored on its computer. Click Next.

NOTE: The server IP address has to be static for Clients to connect to it successfully. Unique
external IP addresses should be used for cloud-based servers.

On the Further Actions page, check the location to which the installation package will be
saved and clear the | want to install the configured Client automatically on remote
computers option. Click Next.

Package creation starts. As soon as the package creation is finished, click Finish.

To install Ekran System Client via the Administrative Panel using a formerly created
installation package, do the following:

Start the Ekran System Administrative Panel.
Select the Ekran System Clients node to the right of the window.
Right click and select Install Ekran System Client.

The Ekran System Client Installation Wizard opens. Click Next on the Welcome page.
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5. On the Ekran System Client Package Mode page, choose the Select Ekran System Client
package option and click Browse.

Ekran System Client Installation Wizard &J
Ekran System Client Package Mode <
Define dient installation package location s %

() Create Ekran System Client packa:

C:\Program Files\Ekran System\Ekran System\Administratc Browse...

@ Select Ekran System Client packac

C:\Program Files\Ekran System\Ekran System\Administratc

[ < Back ][ Next > ][ Cancel

6. Navigate to the formerly created package and select it. Click Next.

7. Continue the installation as described in common remote installation.

To install Ekran System Client using the installation package on the target computer:

1. Copy the package to the remote computer and start it under the Administrator account. By
default, the created package is saved to the following directory: <Ekran System installation
folder>\Administrative Panel\Package\.

2. After the package is deployed, the name of the required computer appears as a sub-node of
the Ekran System Clients node in the Ekran System Administrative Panel.
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Updating the Ekran System Clients

The Ekran System Client updating is performed automatically when a Client connects to the Server
of a newer version. As soon as updates are applied to a Client, you’ll see a warning icon and a non-
restarted status message near the Client name indicating that a reboot of the Client computer is
required.

¥, void (non-restarted)

NOTE: Not restarted Clients do not stop the monitoring and all features of the old Client are still
available to them, but new features will not be available until the Client computer is rebooted.

After a reboot you will also be able to access the monitored data of the old Client.

In some cases, if you install a newer version of the Ekran System Server, Clients of very old
versions will not be able to update and you will see the unable to update status message near the
Client name. In this case you need to uninstall the old Client and install a new version of a Client.

Cloning a Virtual Machine with Installed Client

Each Client has its own unique ID, which it receives when it connects to the Server. When you
prepare a virtual machine, which is to be monitored by Ekran System, for cloning, you need to
remove the Client ID to ensure the proper Client connection to Server.

To remove the Client ID:
Open the Windows Registry Editor.

In the Registry Editor window, select the following key
HKEY_LOCAL_MACHINE\SOFTWARE\EkranSystem.

3. Double-click the AgentGUID value or select it and click Modify in the right-click menu.
. Remove the ID from the Value Data box.
5. Click OK.

Uninstalling Ekran System Clients

You can uninstall more than one Ekran System Client from selected host(s).

To uninstall the Client:

1. Start the Ekran System Administrative Panel.
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Select Ekran System Clients in the navigation pane or details pane.

Select Action > Uninstall Ekran System Client or right-click and select Uninstall Ekran System
Client.

r — ]
=] Ekran System Administrative Panel Lilﬂlﬂ

(=] File Action View Window Help .ZIE
esEEE

=] Ekran System
> & Roles % Roles
“,1 Alerts h
o= =2 Alerts
b | Ay Bl Ekran System Clients

Ekran System

Install Ekran System Client...
Uninstall Ekran System Clients...
Manage Licenses...

Refresh

New Window from Here

Help
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The Ekran System Client Uninstallation Wizard opens.

¥
Ekran System Client Uninstallation Wizard l&r
Uninstall Ekran System Clients...
Select hosts from which you want to remove Ekran System Clients. \
[V] Aleks-A-PC
Check all ] [ Uncheck all
< Back [ Next > ] [ Cancel ]
A

Select the hosts from which Clients will be uninstalled. Select the checkbox near the name of
the corresponding host. You can use the Check All/Uncheck All buttons to select/disselect all
Clients. Click Next.

The uninstallation process starts. After the uninstallation finishes, click Finish to exit the
wizard.

To uninstall a single Client:

Start the Administrative Panel.

Select Ekran System Clients list in the navigation pane.

Right click the target Client and select Uninstall Ekran System Client.
Confirm the Client uninstallation.

If the Client had transferred any user activity records before it was removed, the
corresponding host remains in the list of Ekran System Clients marked as uninstalled. The
respective user activity records are kept stored on the Ekran System Server.
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E Ekran System Administrative Panel

=rE x|
[2) File Action View Window Help (= [=]x]
es | 2E =05

E=] Ekran System Ekran System Clients
> & Roles W Aleks-A-PC
Y Alerts 0
4| A Ekran System Clients |
B Aleks-A-PC

—

™ Uninstalled Client records

Used workstation licenses: 0/50 Used server licenses: 0/50
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Licensing
General Licensing Information

To start receiving information from Ekran System Clients, you have to assign licenses to them.
Two types of licenses are available:

o Workstation license: Clients with this license monitor only one session, either remote or
local, on the investigated computer.

NOTE: Licenses of the workstation type cannot be assigned to a computer with Server
0s.

o Server license: Clients with this license monitor unlimited number of remote sessions and
any local sessions on the investigated computer. Remote sessions include Remote Desktop
sessions, terminal sessions, etc.

Each client can have only one license assigned, either workstation or server.

Initially, when you start the Ekran System Server for the first time on a computer, you have an
embedded trial serial key, which allows you to use 5 workstation licenses and 1 server license for
30 days.

To use the Ekran System permanently and with greater number of licenses, you have to license it
with purchased serial keys.

NOTE: After activation of any serial key, the embedded trial key expires.

Two types of serial keys are available:

e Standard serial keys: These keys allow you to use licenses they contain during the unlimited
period of time and allow you to update the product during 12 months from activation.

e Trial serial keys: These keys allow you to use the licenses they contain during 30 days from
activation and update the product during this period.

Each serial key includes the following parameters:
e Subscription period

¢ Server licenses for Ekran System Clients

o Workstation licenses for Ekran System Clients

You can either activate serial keys online or add activated serial keys if you have no Internet
connection on a computer with installed Ekran System Server. Contact your vendor for
information on purchasing serial keys.

Please note, after the activation, serial keys are bound to a specific computer and cannot be used
on another computer.
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About Subscription

A subscription is a period that defines what updates can be applied to your copy of the product.
Updates are defined by their release date. After the subscription expires, you can still assign
licenses to Clients, but you won’t be able to update Ekran System to versions released after the
subscription expiration date.

The subscription end date is defined during the serial key activation (either via Ekran System
Administrative Panel or on the vendor’s site). It is calculated using a serial key with the longest
subscription period.

For example, if you activate two keys, one with a 30 days subscription period and one with a 12
months subscription period, simultaneously, the subscription end date will be set to 12 months
from the activation date.

When a new serial key is being activated, the subscription period is prolonged accordingly. Please
note, if the current subscription period is longer than the one of a key being activated, current
subscription period doesn’t change. For example, if you activate a key with 12 months
subscription period after a key with 30 days subscription period, the subscription end date will be
set to 12 months since the activation date. But if you activate a key with 30 days subscription
period after a key with 12 months subscription period, the subscription end date will not change.
If your subscription expires, you can purchase a special subscription extension serial key, which
does not contain any keys, but extends your subscription period, or you can activate any other
serial key

To view the subscription expiration date, select Action > Manage Serial Keys or right-click the
Ekran System node and select Manage Serial Keys.

Activating Serial Keys Online

To activate purchased serial keys online, do the following:

1. Make sure you have an active Internet connection on the computer with installed Ekran
System Server.

Start the Ekran System Administrative Panel and select the Ekran System node.

Select Action > Manage Serial Keys, or right-click the Ekran System node and select
Manage Serial Keys.

The Ekran System Serial Keys Management window opens.
Click Activate keys online.
The Ekran System Serial Keys Online Activation window opens.

No v b

Enter serial keys to be activated separating them with spaces or paragraphs and click
Activate.

8. The progress of serial key activation is displayed in the Ekran System Serial Key Activation
window.

9. If serial keys are successfully activated, you will see a confirmation message. Click Close in
the message.
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10. The newly activated serial keys are highlighted in bold in the Ekran System Serial Keys

Management window.

11. The number of available server and workstation licenses and the subscription end date

change.

12. Click Close in the Ekran System Serial Keys Management window.

Adding Activated Serial Keys Offline

If you have no Internet connection on a computer on which the serial keys are to be activated,
you can activate them on the license site and then add the activated serial keys offline. For more
information, send an email to info@ekransystem.com

To activate serial keys offline, do the following:

1.

w

o

On the computer with installed Ekran System Server, start the KeyGenerator.exe file, which
you can find near the Ekran System installation file.

The Ekran System Serial Key Generator window opens.

Click Generate to generate a unique identifier (serial key) for your computer.

When a unique identifier for your computer is generated, copy it to a text file on a
removable drive.

Activate serial keys using the generated unique identifier on your vendor’s license site.
After keys are activated, you will receive the activatedKeys.txt file.

You can copy the file to a removable drive to use it on a computer with installed Ekran
System Server.

To add activated serial keys in offline mode, do the following:

1.

o v kW

N

Start the Ekran System Administrative Panel and select the Ekran System node.

Select Action > Manage Serial Keys, or right-click the Ekran System node and select
Manage Serial Keys.

The Ekran System Serial Keys Management window opens.

Click Add activated keys.

The Ekran System Activated Serial Keys Offline Adding window opens.

Enter the path to the activatedKeys.txt file with activated serial keys in the empty text box or
click Browse and navigate to the required file.

Click Add.

The newly added serial keys are highlighted in bold in the Ekran System Serial Keys
Management window.

The number of available server and workstation licenses and the subscription end date
change.

10. Click Close in the Ekran System Serial Keys Management window.
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Viewing License State

You can view the information on serial keys you have activated or added and license details in the
Ekran System Serial Keys Management window.

To view the license state, select Action > Manage Serial Keys or right-click the Ekran System
node and select Manage Serial Keys.

The following information is displayed in the Ekran System Serial Keys Management window
header:

e Subscription end date: The subscription end date is taken from the serial key with the
longest subscription end date.

e The number of workstation licenses used out of total number: The number of workstation
licenses is summed up from all activated serial keys.

e The number of server licenses used out of total number: The number of server licenses is
summed up from all activated serial keys.

e The number of not licensed Clients: Displays the number of installed Clients with no licenses
assigned.

The following information is displayed in the Ekran System Serial Keys Management serial key
table:

e Serial key

e Activation date

e Deactivation date (for deactivated keys only)
e Number of workstation licenses

e Number of server licenses

e Key state: activated/deactivated/ expired. For a trial serial key, an expiration date is
displayed near the key state.

Deactivating Serial Keys

If for some reason you’ve decided to discontinue using Ekran System, you can deactivate serial
keys.

To deactivate a serial key, do the following:

1. Make sure you have an active Internet connection on the computer with installed Ekran
System Server.

Start the Ekran System Administrative Panel and select the Ekran System node.

Select Action > Manage Serial Keys, or right-click the Ekran System node and select
Manage Serial Keys.

4. The Ekran System Serial Keys Management window opens.
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5. Select a serial key to be deactivated and click Deactivate.
NOTE: Expired serial keys can’t be deactivated.
In the confirmation message, click Deactivate.
Click Yes, when asked to confirm the deactivation.

The progress of serial key deactivation is displayed in the Ekran System Serial Key
Deactivation window.

9. If aserial key is successfully deactivated, you will see a confirmation message. Click Close in
the message.

10. The deactivated serial key is marked as Deactivated in the State column of the Ekran System
Serial Keys Management window.

11. The number of available server and workstation licenses and the subscription end date
change.

12. Click Close in the Ekran System Serial Keys Management window.

Ekran System Client License Management

Ekran System Client license management is performed in the Administrative Panel.

You can assign a license to a Client or unassign it manually any time. The license can be assigned
to an off-line Client and it will be applied after the Client is on-line. The license can be moved from
one Client to another. If the Client is uninstalled, its license becomes free and can be assigned to
another Client.

NOTE: When a trial serial key expires, the corresponding number of licenses is automatically
unassigned from Clients.

Information about the number of used and free licenses of each type is displayed in the status bar
of the Administrative Panel and in the Ekran System Serial Keys Management window.

You can manage either licenses for a single Client, or licenses for multiple clients.

To assign the license to one Client, do the following:
1. Start the Ekran System Administrative Panel.
2. Select Ekran System Clients in the navigation pane or details pane.

3. Navigate to the Client, to which the license should be assigned. Right click and select
Add Workstation License (Add Server License).

4. The license is added to the Client and it starts session monitoring.

To unassign the Client license, do the following:
1. Start the Ekran System Administrative Panel.
2. Select Ekran System Clients in the navigation pane or details pane.

3. Navigate to the Client, from which the license should be unassigned. Right click and
select Remove License.
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4. The license is removed the Client and it stops session monitoring.

NOTE: to change the Client license type you don't need to unassign the current license. This will
be done automatically.

To manage licenses on several Clients, do the following:
1. Start the Ekran System Administrative Panel.
2. Select Ekran System Clients in the navigation pane or details pane.
3. Right click and select Manage Licenses.
4. The Ekran System Clients Licensing Wizard opens.

¢ Inthe Workstation Licenses list, select the hosts to which the workstation
license will be added. Check the corresponding check boxes. To select all hosts,
click Check All. To clear selection for all hosts, click Uncheck All.

e Inthe Server Licenses list, select the hosts to which the server license will be
added. Check the corresponding check boxes. To select all hosts, click Check All.
To clear selection for all hosts, click Uncheck All.

NOTE: A client can't be selected in both lists. Licenses from all hosts not selected in any list will
be removed.

5. Click Next. The process of licenses adding/removing starts. When the process finishes,
click Finish.

Troubleshooting

Checking that the Client Is Installed

You can check if the Ekran System Client is installed on the investigated computer in one of the
following ways:

¢ The EkranService.exe process is started;
e The EkranClient and EkranController services are present;
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A Computer Management
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> §a] Event Viewe
> @2 Shared Fold
> & Local Users

R Al i NERCNESN 7 Boel

~

__|| EkranClient Name Description Status *
3 @ gerf?rmh;nc ) £/ Distributed Transa... Coordinates...
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=9 Disk Manag|~
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o PERICES EkranClient 2 £ ina File Sv.. Provi =
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There is a <system disk>:\Program Files\Ekran System\Ekran System\Client\ folder with

executable files;
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@Ovl . <« Ekran System » Client v | 5 H Search Client ,Ol
Organize v Open New folder Bz » [ @
<% Favorites *  Name . Date modified Type =
B Desktop ;__; ClientActivity_6092 12.02.2013 8:51 Text Docur
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The HKEY_LOCAL_MACHINE\SOFTWARE\EkranSystem key has the following values:
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1. Open Windows Explorer.

2.

Clients Installation Issues

The common reasons of issues with remote installation or uninstallation of Ekran System Clients
are the inadequate network configuration or system settings.

For successful remote installation, Ekran System needs to access the administrative shares on the
target computers.

To check the administrative shares availability, do the following:

In the address bar type \\<target_computer_IP>\admin$ and press Enter.
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o5 S

—— = e —
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4 Downloads —
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" 5 items

3. When the Enter Network Password window opens, enter Administrator credentials and click

4.

OK.
If the login credentials are accepted, the system folder opens (by default, C:\Windows).

If you get an error after performing step 2, try the following:
e Open the Command Prompt (cmd.exe). Enter and execute the ping
<target_computer_name or IP> command. Check the following:
1. If you do not get ping replies, network may be down. Check the
network connection and try again.
2. If the network is up, but you don't get the ping reply, check the firewall
on the remote computer. Disable the firewall on the target remote
computer.
e If you are receiving ping replies, but the administrative share is still unavailable, check that
the Sharing Wizard or the Simple file sharing are disabled.

o If you are receiving ping replies and the sharing options are good, but you still cannot
access the administrative shares, check that the Server system service is running on the
remote computer.

¢ If none of the mentioned helps to solve the problem, contact your System Administrator.

If you get a login error after performing step 3, try the following:

e Make sure that the credentials you enter are correct. You have to enter the credentials of
a Domain Administrator or a local Administrator account on the remote computer.
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o Verify that the account password is not empty. Accounts with empty passwords cannot be
used for remote connection.

e Try typing the username as <domain_name>\<username> if the remote computerisin a
domain, or <computer_name>\<username> if the PC belongs to a workgroup.

¢ If none of the mentioned helps to solve the problem, contact your System Administrator.

DNS

Try using the remote computer's IP address if you cannot access it by the name. DNS service may
be unavailable in your network.

UAC

If you access the administrative shares normally on the remote PC running Window Vista or
Windows 7, but the Ekran System Client remote installation fails, make sure the User Account
Control is disabled on the remote computer.

Remote Client Installation Issues

If you encounter problems with remote installation of Ekran System Clients in a workgroup under
Windows 7/Vista, try enabling the Local Account Token Filter Policy.

NOTE: This is a known Windows issue that might block remote application installation.

To enable Local Account Token Filter Policy:
1. Open the Windows Registry Editor.

2. In the Registry Editor window, select the following key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System

3. Double-click the LocalAccountTokenFilterPolicy value, or select it and click Modify in the
right-click menu.

In the Value data box, type 1, and then click OK.
Close the Windows Registry Editor.

Deploy Ekran System Client.

Open the Windows Registry Editor.

© N o ok

In the Registry Editor window, select the following key:
HKEY _LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System

9. Double-click the LocalAccountTokenFilterPolicy value or select it and click Modify in the
right-click menu.

10. In the Value data box, type 0, and then click OK.
If the LocalAccountTokenFilterPolicy registry value does not exist, follow these steps:

1. Inthe Windows Registry Editor in the Edit menu, click New, and then click DWORD Value.
2. Type LocalAccountTokenFilterPolicy and then press ENTER.
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Administrative Panel

Administrative Panel Properties

Ekran System Administrative Panel properties define main properties of data storage.
To define Ekran System properties:

1. Select Action > Properties or right-click on the Ekran System node and select
Properties.

2. The Ekran System Properties window opens.

Ekran System Properties @Iéj
Storage

Storage location (Firebird only)
Databaze:

Browse. ..

Storage deanup
Define date period:

Start date: 18.09.2013 [E- End date: 18.09.2013 [E= Remove data

Database automatic deanup

|:| Turn on automatic Server storage deanup

0:00:00

Shrink database (M350L only)

Shrink database

QK. ] [ Cancel Apply

M

3. Define the following settings:

e Click Browse and navigate to the new storage path for screen captures saving.

e Select the dates in the Start date and End date boxes and click Remove data to
delete all screen captures created between the specified dates.
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e Select the Turn on automatic Server storage cleanup check box to enable
automatic database cleanup.
Define the following parameters:

e The period for data to be stored before cleaned up automatically.
e The time for cleanup operation execution.

e Host exceptions list is used to define the computers with Ekran System Clients
installed whose data will not be deleted during the automatic Server storage
cleanup.

NOTE: The exceptions are not available during manual Server storage cleanup.
4. Click OK to accept the changes and close the window.

The following properties are available:

Storage location: This option defines where created screen captures will be saved and also
allows you to move the database to another location. Please make sure that you have
enough free space at the selected location.

Storage cleanup: This option allows you to delete stored data manually or automatically
not to run out of disk space.

Database automatic cleanup: This option allows you to delete stored data from the
defined hosts automatically with the defined frequency.

Administrative Panel Interface

Ekran System Administrative Panel Interface

Ekran System Administrative Panel interface includes the following parts:

Navigation pane (Console tree): This pane includes the tree with one main node Ekran
System and three main sub-nodes: Roles, Alerts and Ekran System Clients. The Roles node
gives you access to the list of users that can use the Ekran System Monitor. The Navigation
pane can be hidden by selecting View > Customize and clearing the Console tree box.

Details pane: This pane displays the contents of the node currently selected in the
Navigation pane for Roles nodes and the Host configuration for Hosts nodes. Data in the
Details pane can be displayed in one of four standard representations: Large icons, Small
icons, List, and Details.

Toolbar: The toolbar allows you to navigate between the objects quickly and adjust
program interface. It includes Back, Forward, Up One Level, Show/Hide Console Tree,
Export List, and Hide.

Main menu: It includes four menus: File, Action, View, Window, and Help.
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-
E Ekran System Administrative Panel

(=] File Action View Window Help Main menu _ |8 x|
e Al i HENETN 7 e Toolbar
@ EksonSysiem Ekran System
\‘j‘ i::: ‘i*; Roles
o Alerts

b li
- R iy A Ekran System Clients

Navigation pane Details pane

Used workstation licenses: 0/50 Used server licenses: 0/50

Ekran System interface can be adjusted through the View menu. The following commands are
available:

Add/Remove Columns: Defines the number of columns displayed in the Details pane.
Large icons, Small icons, List, and Details: Data representation in the Details pane.

Customize: Defines interface elements to be visible. You can enable\disable displaying of
the Navigation pane (Console tree), Toolbar, Action and View menus, the toolbar, the
status bar (in the bottom), the description bar (above the Details pane), etc.
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-
Customize View I l

Select or dear the check boxes to show or hide items in the
console window.

i} o

[¥] standard menus (Action and View)
(V] Standard toolbar

(V] status bar

|| Description bar

[¥] Taskpad navigation tabs

[¥] Action pane

Snap-n
(¥ Menus

[¥] Toolbars

Administrative Panel Options

To get access to options, select File > Options.

The Administrative Panel Options allow you to clean the personal settings file records. When you
modify the displaying of consoles (for example, by changing the size of a window or adding a new
window), MMC saves these settings in a file that preserves your personal settings. The personal
settings file records all changes that are made to a console in user mode.

Only the settings that are associated with your profile are deleted. Ekran System Administrative
Panel will then display by using the default display settings.

This option is useful if you want to restore the default display settings or if disk space is low.

70



vl EKRAN SYSTEM
.rOptions &‘

Disk Cleanup

Chanaes to the view of a console file are saved in your profile.

The files in your profile that store these console changes are using the
following amount of disk space on this computer:

524.4KB | DeleteFiles |

To permanently delete these files, dick Delete Files.

Users and Roles

About Roles

Roles define the sets of Windows users with certain permissions.

Two roles are available in Ekran System:

¢ Administrator: These users are allowed to start both the Ekran System Administrative
Panel and the Ekran System Monitor.

e Supervisor: These users are allowed to start only the Ekran System Monitor.

The roles can be assigned both to users and local groups of the domain and the local computer on
which the Ekran System Server and Administrative Panel are installed.

Assigning Roles to Users

There are two ways to assign a role to a user:
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e Enter a user name manually;
e Select a user automatically.

To add a user manually, do the following:

1. Select arole (Administrator or Supervisor) in the Navigation pane or Details pane.
Select Action > Add new user or right-click and select Add new user.

B Ekran System Administrative Panel E@Iﬁ

(=] File Action View Window Help
e 2@ =2 HE

=] Ekran System

L= 8] %]

Roles
4 P“,ROI?S,, i L 1% Administrator
> |k Administrator, 2 Supervisor
2 Sup Add new user...
b Y Alerts Add new user group...
> A Ekran S

New Window from Here

Help

Add a new user

.

3. The Select Users window opens.

-

Select Users

Select this object type:

gers Object Types...

From this lacation:

dev local Locations. ..

Enter the object names to select (2amples):

D

Check Mames

—

o ) o

4. Enter the user name in one of the following formats:
e First Name Last Name (e.g., John Doe)
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e User name (e.g., user_john)

e User name@Domain name (e.g., user_john@domian1)
e Domain name\User name (e.g., domainl1\user_john)
5. Click Check Names to check that the name is entered correctly.

6. Click OK to add the user.

To add a user automatically, do the following:

1. Select a role (Administrator or Supervisor) in the Navigation pane or Details pane.

Select Action > Add new user or right-click and select Add new user.

E Ekran System Administrative Panel

(=] File Action View Window Help

ol A2l G RESN 7 Me

Ekran System
4 & Roles
> | i Administrator |

LRJ Supé Add new user...

s
b Alerts yJ Add new user group...

> A Ekran S
New Window from Here

Help

Roles

& Administrator
% Supervisor

Add a new user
S

3. The Select Users window opens.
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-
Select Users

r

Select this object type:

|zers

From this location:

dev local

Enter the object names to select (sxamplas):

Ohject Types...

Locations...

Check Mames

i

] [ Cancel

ox
e

4. Click Advanced.
5. The secondary dialog-window opens.

-
Select Users

ERE=)

Select this object type:

Fram this location:

dev local

Common Queries

Ohject Types...

Locations...

Description: | Starts with

[7] Dizabled accounts
[] Mon expiring password

Days since last logon: :]

Columns. ..
Find Mow

Stop

Search results:

oK

Cancel

Mame (RDM) E-Mail Address In Folder
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6. Define the query for User search:

e In the Name box, define the user name condition. Select the comparison operator from
the drop-down list (Starts with or Is exactly). E.g., the User Name starts with "An". This
will find users Andrew, Ann, and Angele.

¢ In the Description box, define the user description condition. Select the comparison
operator from the drop-down list (Starts with or Is exactly). E.g., the User Description is
exactly "John Doe". This will find a user with description John Doe.

o Select the Disabled accounts options to select only users with disabled accounts.

7. Click Find Now to start search.

8. The users are found and displayed in the list. Select the users to be added to Ekran System
and click OK.

9. The selected users are displayed in the corresponding field of the main Select Users window.

Click OK.

Assigning Roles to User Groups

There are two ways to define a user group:
e Enter a user group name manually.
e Select a user group automatically.

To add a user group manually, do the following:
1. Select a role (Administrator or Supervisor) in the Navigation pane or Details pane.
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2. Select Action > Add new user group or right-click and select Add new user group.

r B
[=] Ekran System Administrative Panel LE‘M

=] File Action View Window Help

«s | 2@ =B

[ [&] ]

=] Ekran System Roles
" E“ B°|.esd — & Administrator
> A rr}mlst[ator R Supervisor
2 Sup Add new user...
b Y Alerts

Add new user group...
M Ekran Sy
New Window from Here

Help

Add a new user group

[

3. The Select Groups window opens.

-

Select Groups

Select this obhject type:

Groups or Built-in security principals

From this location:

dev local Locations. ..

Enter the object names to select (2xamples):

HE

Check Mames

ok ) [Gmes

4. Enter the user group name.

5. Click Check Names to check that the name is entered correctly.
6. Click OK to add the user group.

To add a user group from the search list, do the following:
1. Select a role (Administrator or Supervisor) in the Navigation pane or Details pane.
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| S—

2. Select Action > Add new user group or right-click and select Add new user group.

[=] Ekran System Administrative Panel

E=SEcE™ )
[ File Action View Window Help [ [=]x]
e ] o NEY
=] Ekran System Roles
“ R B_c_)_l_e‘sf} 1% Administrator
> | @ Administrator ! :
T 2 Supervisor
2 Supe Add new user...
b Y Alerts Add new user group...
» M Ekran Sy
New Window from Here
Help
Add a new user group
[N 4
3. The Select Groups window opens.
'
Select Groups ?
Select this object type:
Groups

Object Types...
Erom this location:
Aleks-A-PC

Locations...
Enter the object names to select (examples):

?7 Check Namgs |

Advanced... L

E

4. Click on the Advanced button.

5. Select Groups window now displays advanced options.
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Select Groups M

Select this object type:

==
umr

From this location:
Aleks-A-PC Locations...

Common Queries

Mame Starts with = =
Description: | Starts with m
Disabled accounts Stop

Non expiring password

Search results:

Name (RDN) In Folder

6. Define the query for Groups search:in the Name box, define the user name condition. Select
the comparison operator from the drop-down list (Starts with or Is exactly). E.g., the User
Name starts with "An". This will find users Andrew, Ann, and Angele.

7. Click on the Find Now button to start search.

8. The user groups are found and displayed in the list. Select the user groups to be added to
Ekran System and click OK.

9. The selected user groups are displayed in the corresponding field of the main Select Groups
window. Click OK.
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Changing Roles

You can change a user or a user group role when necessary.

To change a user or a user group role, do the following:

1. Select the target user or user group in the navigation pane or the details pane.
2. Do one of the following:

e Right click a user or a usergroup under Administrator node and select Change role to
Supervisor.

e Right click a user or a usergroup under the Supervisor node and select Change role to
Administrator.

~

r
@ Ekran System Administrative Panel

|5 e S

(=] File Action View Window Help
es| 2= B

@ Ekran System

- || E X

’ Roles
4 W Bl i & Administrator
4 [} Administrator :
b& e |l & Supervisor
" Sul Change role to Supervisor
Y% Alerts | Remove user
A Ekran|

New Window from Here

Help

Change role to Supervisor

3. The current user or user group role is changed and the target item is moved to the
corresponding node.

Removing Roles

To remove a user or a user group role, do one of the following:
Select a required user in the Navigation pane or Details pane.
Do one of the following:

¢ Right-click and select Remove user.
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e Select Action > Remove user.

-
E Ekran System Administrative Panel

View

New Window from Here

Export List...

Help

=NEEl X

(=] File Action View Window Help =&
9| 2E = HE
E= Ekran System Name UPN Class
4 @ Roles o :JAdministrators Grou

4 3 Administrator

R AT .
2 Supel Change role to Supervisor

Y% Alerts Remove user

> M Ekran Sys

i J

Delete selected item

|-

The selected user or user group are removed from the node and deprived of the respective role.

Working with Data

Moving Ekran System Server Database

For some reason, you may need to change the location of the Ekran System Server database to

another disk or directory.

To change the location for Ekran System Server database:
1. Start the Administrative Panel and select the Ekran System node.

2. Select Action > Properties or right-click on the Ekran System node and select Properties.
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3. The Ekran System Properties window opens.

F 5
Ekran System Properties M
Storage

Storage location (Firebird only)
Database:

Browse. ..

Storage deanup
Define date period:

Start date: 18.09.2013 [~  Enddate: 18.08.2013 [+

Database automatic deanup

|:| Turn on automatic Server storage deanup

Leave sessions in database (daws):

Time For cleanup operation execukion: 0:00:00
Hosts exceptions lisk: View...
Shrink database (M350L only)

Shrink database

[ Ok ][ Cancel ] Apply

L

4. In the Storage location group of options, do one of the following:
¢ Inthe Database box, enter the path to the database manually.
e Click Browse and navigate to the destination folder.

5. Click OK to accept the changes and close the window.

Deleting Data

There are two ways to perform Ekran System Server database cleanup:
e Manually
e Automatically

To delete data from the Ekran System Server manually:
1. Start the Administrative Panel. Select the Ekran System node.
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2. Select Action > Properties or right-click on the Ekran System node and select Properties.
3. The Ekran System Properties window opens.

Ekran System Properties @I&J
Storage

Storage location (Firebird only)
Database:

Browse. ..

Storage deanup
Define date period:

Start date: 18.09.2013 [Jv  Enddate: 18.09.2013 [+

Database automatic deanup

|:| Turn on automatic Server storage deanup

0:00:00
View...
Shrink database (M35QL only)

Shrink database

[ ak ][ Cancel ] Apply

4. Under Storage cleanup, define the dates in the Start date and End date boxes and click
Remove data to delete all screen captures created within the specified time range.

5. Click OK to accept the changes and close the window.

To delete data from Ekran System Server automatically:
1. Start the Administrative Panel. Select the Ekran System node.
Select Action > Properties or right-click on the Ekran System node and select Properties.
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3. The Ekran System Properties window opens.
i Ekran System Properties m1
Storage

Storage location (Firebird only)

Database:
ogramData'\Ekran System'\Ekran System'EkranActivityDEB. Browse. ..
Storage deanup

Define date period:

Start date: 18.09.2013 [~  Enddate: 18.08.2013 [+

Database automatic deanup

|:| Turn on automatic Server storage deanup

Leave sessions in database (daws):

Time Far cleanup operation execution: 0:00:00
Hosts exceptions lisk: View...
Shrink database (M350L only)

Shrink database

[ K ] [ Cancel Apply

b

Select the Turn on automatic Server storage cleanup check box.

5. Define the number of days to store data before deleting. Define the time to execute the
clean-up operation.

6. Click View to define the host exceptions. Hosts in the exceptions list will not have their
sessions deleted from the database.
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-
Ekran System Automatic Cleanup Exceptions

Ekran System Automatic Cleanup Exceptions >,
Select hosts, sessions from which will not deleted during auto deanup

Aleks-A-PC

[ Checkal | [ uncheckall

7. Click OK to accept the changes and close the window.

8. Automatic database clean-up will be performed with the defined interval at the selected
time.

Shrinking Database

The database shrinking feature allows you to shrink the size of the MS SQL database to the actual
amount of the data stored in it by cutting the space reserved by the database, but which is not
used by it.

NOTE: The database shrinking procedure may take some time (up to several hours) and cause
performance slowdown.

To shrink a database, do the following:

1. Start the Administrative Panel. Select the Ekran System node.
2. Select Action > Properties or right-click on the Ekran System node and select Properties.
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3. The Ekran System Properties window opens.

Ekran System Properties @lﬂ—hJ

Storage

Storage location (Firebird only)
Database:

Browse...

Storage deanup
Define date period:

Startdate: 18.09.2013 [J+  Enddate: 18.08.2013 [+

Database automatic deanup

|:| Turn on automatic Server storage deanup

0u00:00
View. ..
shrink database (M350L only)

Shrink database

[ Ok J [ Cancel Apply

4. Click Shrink database.

NOTE: The progress of the database shrinking process is not displayed in the Administrative
Panel and there is no indication of the process finishing.

Alerts

About Alerts

Alerts are instances that notify the investigator of a specific activity (potentially harmful/forbidden
actions) on the target computers on which Clients are installed and allow the investigator to
respond to such activity quickly without performing searches.

The notifications can be received in email or tray. Besides screen captures generated on alert
events are marked as Alert in the Monitor.
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Alert system can be used for two purposes:

¢ Immediate response: This allows the investigator to get immediate information about the
forbidden action and respond to it quickly (almost at once).

e Delayed response: This allows the investigator to get information on batch of forbidden
actions on multiple clients, analyze them and then respond.

Alerts Management

Adding Alerts

To add an alert, do the following:
1. Right-click the Alerts node and select Add new alert.

L N UL R WN

New Window from Here

Help

r | bl
E=] Ekran System Administrative Panel l o | & l_-g_h,l
(=] File Action View Window Help REE
=@ H =

Ekran Syst

E RSy — Alert global settings
% Roles
Y Alerts| E-mail settings

A B Add new alert SMTP mail server: | Port: | 25 -
Enable all User: I
Disable all Password: I
Refresh
Vicew » Frequency settings

Minimal interval between the same alert events on one session (min): |10 =

¢ Send notification on every alert event

" Send batch notification every: |° j hours ll‘:‘ :J] minutes

~Tray notifications journal

Maximum number of alert events displayed in the journal: 500 =

L

Define alert parameters.

Define at least one rule.
Click Save to save the created Alert.
The Alert appears in the tree-view.

A new alert sub-node appears in the tree-view.

The Alert editing area for the new alert opens to the right.

Enter a unique alert name and alert description (optional).

Click Browse and select hosts to which the Alert will be assigned.
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Editing Alerts

To edit an alert, do the following:
1. Left-click an alert sub-node in the tree-view.
2. The Alert editing area for the new alert opens to the right.

=] Ekran System Administrative Panel

(=] File Action View Window Help

e 2Bl

Ekran System
E L [V Enable Alert

™ Show warnings in Ekran Systen

» & Roles
4 % Alerts - Alert Info
%> Facebook alert Alert name: NewAlert
Y Twitter alert o
" NewAlert s
> M Ekran System Clients
Assign to: I Browse... I
—Actions
™ send email: I

—Rules

Parameter ] Comparison operator | Value

Edit...

3. Edit the parameters you need.
4. Click Save button.
5. The edited parameters are saved.
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Viewing Alerts

Alerts are displayed in the tree-view pane to the left. The Alerts node is displayed in the tree-view

between the Roles and the Ekran System Clients nodes. Alerts are displayed as sub-nodes of the
Alert node. Each alert sub-node is named with a unique Alert name.

When an alert node is selected, its parameters are displayed in the pane to the right and can be
edited.

=] Ekran System Administrative Panel @M

E File Action View Window Help
= 2B

=] Ekran System

BEIE

> & Roles [V Enable Alert
4 Yp Alerts —Alert Info
% Facebook alert Alert name: Twitter alert
% Twitter alert|
‘;NewAle;t i Description: -

> A Ekran System Clients

Assign to: | Aleks-A-PC; Browse... I

—Actions

™ Send email: I

[V Show warnings in Ekran Systen

~Rules
Parameter I Comparison operator I Value Edit... I
Title Like twitter
< 1 P

Save |

Deleting Alerts

To delete an alert, do the following:
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1. Right-click an alert sub-node in the tree-view and select Delete alert.

_
=] Ekran System Administrative Panel

(=] File Action View Window Help

2| 2EHm

=] Ekran System

[V Enable Alert

View

New Window from Here

> & Roles
4 % Alerts - Alert Info

% Facebook alert Alert name: Twitter alert

% Twitter alert!

% NewAlert Disable alert &
> M Ekran System Delete alert

Browse... |

Help
™ send email:
[V Show warnings in Ekran Systen
—Rules
Parameter l Comparison operator | Value Edit... |
Title Like twitter

1 2

Save |

2. The confirmation message appears.

3.
4.

Click Yes.
The alert is deleted.

Alert Parameters

The Alert editing pane allows you to define the Alert settings and rules.
To edit the Alert Parameters, do the following:
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1. Select the required Alert from the Alerts node in the tree-view pane to the left.

2. The Alert editing pane opens to the right.

-
Ekran System Administrative Panel

= | 7[E H=

(=] File Action View Window Help

=] Ekran System
> & Roles
4 Y Alerts
%> Facebook alert
" Twitter alert
% NewAlert
> A Ekran System Clients

[V Enable Alert

—Alert Info -

Alert name: Twitter alert

Description:

Assign to: I Aleks-A-PC;

—Actions

L

~Rules -

™ Send email: I

[V Show warnings in Ekran Systen

Parameter j_Comp_arison operator _"_Value
Title Like twitter

< T

| Edit... |

Save l

3. Enable/disable the selected Alert by checking/clearing the Enable Alert check box. If
the Alert is disabled, you will not receive notifications on it (the screen captures will not be
marked as Alerts in Monitor as well).

4. Create a unique name for the created Alert and enter a description to this Alert in the

Description box, if necessary.
5. Click Browse to select hosts to which the Alert will be applied.

6. The Host Assigning window appears.

7. Check the check boxes near the target clients. Click Check all to apply the Alert to all
clients. Click Uncheck all to clear all check boxes.
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8. To receive email notifications on alert events, check the Send email check box and
enter the email address to which the notifications will be sent. You can enter several email
addresses, separating them with semicolon.

9. Check the Show warnings in Monitor tray check box to activate the tray notifications.
The Alert notifications will then pop up from the tray on all computers with started Monitor.

10.In the Rules group, click Edit to define the rules for the created Alert. At least one rule
has to be defined.

11.Click Save to save the changes.

Rules

Alert rules allow the investigator to determine what events on the investigated computer will be
considered alert. Each alert has to have at least one rule. Rules applied to one parameter are
combined with OR logic, rules applied to different parameters are combined with AND logic.

Rules are displayed in the grid in the Rules group in the Alerts editing pane.

Each rule consists of the Parameter, Comparison operator and Value, to which the Parameter will
be compared.

To edit the rules, click the Edit in the Alert editing pane, the Rules window appears.
To define a new rule, in the Rules window, do the following:

1. Select Application, Title or Name from the Parameter drop-down list.

2. Select the Comparison operator for the selected Parameter.

3. Enter the Value.
To delete a rule, clear the Value box in the Rules window.

The following parameters are available for the rules

Parameter Description Example

Application The name of the started application on the investigated skype.exe
computer. Set this parameter type for Alert to be activated
whenever the specified value is identified as the name of a
launched application.

Title The name that appears in the title of a window. Set this Facebook
parameter type for Alert to be activated whenever the
specified value is identified in any title on the screen.
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User name The name of the Windows user whose work is monitored by John

Ekran System. Set this parameter type for Alert to be
activated whenever the specified user uses the computer on
which the Client is installed.

Comparison operators for text data:

Equal to: The defined value fully corresponds to the found result (e.g., John will find John,
but will not find Johny);

Like: The found result includes the defined value (e.g., John will find Johny, Johnatan, but
will not find Johan);

Examples of Rules

1.

2.

3.

To set up the alert notification about any user opening Facebook on the investigated
computer, enter the following parameters:

Rules L—J&

Parameter: Operator: Value:

l‘l’lﬂe _v_I |Like _v_] I facebook

To set up the alert notification about a specific user (e.g. Stefan) opening Facebook on
the investigated computer, enter the following parameters:

[ Rules li_&r

Parameter: Operator: Value:

!Tltie _VJ ILike L] I facebook

lUser name LI |Equa! to L] |Stefan

If you enter more than one name, the alert notification will then appear if any of them
(Stefan or Rick) opens Facebook.

rHl..lles I&1

Parameter: Operator: Value:
ITitle x| Juke | |facebook
lUsername  v| |Equalto ~| [Stefan
|Llsername ﬂ |Equalb:| j |Rit:k|

To set up the alert notification about any user launching skype.exe application on the
investigated computer, enter the following parameters:
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(Rules &J‘

Parameter: Operator: Value:

|Application L] IEquaI to Ll Iskype.exe

4. To set up the alert notification about a specific user (e.g. Stefan) launching skype.exe
application on the investigated computer, enter the following parameters:

rHl..lles @1

Parameter: Operator: Value:
|.-5.p|:||i|:.ati|:-n j |Equa|b:| j |sk1,-'|:-e.exe

|I_Isername ﬂ |E|:||.|a|b:| ﬂ |5tEfEll‘l

If you enter more than one name, the alert notification will then appear if any of them
(Stefan or Rick) launches skype.exe.

rF‘..l..llnes @1

Parameter: Operator: Value:
|.ﬁ.pp|i|:atil:un ﬂ |E|:||.|a| to j | skype.exe|
|Llser name j |E|:|ual to j | Stefan
|Llser name j |E|:|ual to j | Rick

5. To set up the alert notification about a specific user (e.g. Stefan) using the investigated
computer, enter the following parameters:

Rules I-Z_hj

Parameter: Operator: Value:

User name _v_] |Equalto L’ IStefanI

Defining Alert Global Settings

Alert global settings define notification settings for all Alerts. These settings are applied to all
Alert and to all Ekran System Monitors connected to this Server.

To define Alerts global settings, click the Alerts node. The Alert global settings pane will appear
to the right.
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> A Ekran System Clients Password: |

Frequency settings

Minimal interval between the same alert events on one session (min): | 10 “E_]“]

¢ Send notification on every alert event
{" Send batch notification every: |0 :J‘l hours I 10 j minutes

~Tray notifications journal

E

Maximum number of alert events displayed in the journal: 50 ﬂ

Save

r T Y
=] Ekran System Administrative Panel | =) = l&l
File Action View Window Help - [&] %
e 4l 4] 53} ? W=
= Ekran System
E y -Alert global settings

& Roles
4| Alerts ~E-mail settings
% Facebook alert SMTP mai . Port: | 25 =l
3 : mail server: | =
» Twitter alert
x User: |
o+ NewAlert

The E-mail settings group allows you to define a sender of the email alert notifications.

¢ Define an existing SMTP mail server.
NOTE: The delivery of email notifications via mail servers with only NTLM
authentication, such as Microsoft Exchange Server, is not supported.

¢ Define the number of the Port via which the emails will be sent.

e Define the login details (User and Password) of an existing email account, from which
the email notifications will be sent.

The Frequency settings group allows you to define how frequently the Alert notifications will
appear in the Monitor Tray and be sent via email.

Define the Minimal interval between notifications sent for the same alert event. This option
defines how frequently the notifications about the same alert event will appear. For example,
if this parameter is set to 10 minutes and a user has started Skype and works in it, the
investigator will receive one notification every 10 minutes instead of receiving 10 notifications
every minute or even more.

Define the way in which the notifications will be sent:

¢ Select Send notifications on every alert event for the notification on every alert event to
be sent to the investigator.
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e Select Send batch notification every for information on all alert events during defined
time interval to be sent to the investigator.
¢ If Send batch notification every is selected, then define time interval in hours and
minutes. Time counting starts when Server starts if this option is selected. Notifications
are then sent with the defined frequency.
The Tray notifications journal group contains only one parameter that allows the investigator to
define the maximum number of events displayed in the Tray Notification Journal. When it is
reached, the oldest records are removed from the journal of all Ekran System Monitors (but not
from the database).

Client Configuration

Hosts are computers on which Ekran System Client installed. After the Client is installed on the
computer it appears in the Hosts list of the Administrative Panel to which it connects.

Ekran System Client configuration is defined during installation or after the installation through
editing the Ekran System Client configuration.

To edit the Ekran System Client configuration:

1. Select the required host under Ekran System Clients.
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2. The configuration options are displayed in the Details pane.

«= | 2EHE

~
=] Ekran System Administrative Panel l = | & Iﬁl
File Action View Window Help [ [[&][x]

=] Ekran System

> & Roles

4 S Alerts
% Facebook alert
% Twitter alert
% NewAlert

4 A Ekran System Clients Bit depth: 3 bits LI
8 Aleks-A-PC

~Ekran System Client Settings

r—~Common

—Screen capture color settings -

—Screen capture creation settings - 9

I” Capture screen periodically

EL

30

[V Capture screen on active window change
[ Check changing of names of window
[V Capture screen on dicking and key pressing

rKeystroke Logging -

[V Enable keystroke logging

Save |

A

3. Define the required screen capture quality. This option allows you to define the color depth
of the created screen captures.

4. Define the screen captures creation frequency. This option allows you to define how often
the screen captures on the Client computer will be created. Screen captures can be created
by three parameters:

e Capture screen periodically: screen captures will be created with a certain
time interval. Irrespective to whether something changes on the screen or not.

e Capture screen on active window change: screen captures will be created on
the change of the active window. For example, a new window opens (program
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starts), a new tab in the browser opens, any secondary window opens, etc.
(influences the keystroke logging as well).

e Check changing of names of window: screen captures will be created on the
change of the name of the active window (influences the keystroke logging as
well).

e Capture screen on clicking and key pressing: screen captures will be created
on each mouse click or keyboard key pressing.

If you want the keystroke logging to be enabled, select the Enable keystroke logging
checkbox.

NOTE: The keystrokes are not logged in a virtual machine session. To log keystrokes from a
virtual machine session, you need to install a Client on the virtual machine.

Click Save.

A new configuration will be immediately applied to the host.

Exporting Data

Ekran System Administrative Panel allows you to export the list of roles and/or hosts to the *.txt
and *.csv format.

To export data:

In the Navigation pane, expand the category to be exported, e.g., Hosts (to export the lists of

all hosts connected to the Administrative Panel) or Administrator (to export the list of all
Windows users to whom the Administrator role is assigned).
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2. Select Action > Export List or right-click and select Export List.

EKRAN SYSTEM

-
=] Ekran System Administrative Panel

(=] File Action View Window Help

e 2@ =

E=J Ekran System Roles
b ]k_ P |
Y > View

New Window from Here

Export List...

« N Help

Exports the current list to a file.
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3. Select the name of the file to which data is to be exported and its format.

>
[=] Ekran System Administrative Panel

1 = Export List

Savein: [ Libraries - 0> mE
@@= = '
e‘} ‘hl Documents ID hiicic
- s Lib Vibiiars

RecentPlaces = Y &7 Horany
' m Pictures p=.  Subversion

- ‘\7 Library \.:</> Library
Desktop
L Videos
i 5 ; g Library
Libraries

!

LY
Computer
Network

File name: |

Save as type:

| Text (Tab Delimited) (" bd)

1l

[ ] Save Only Selected Rows

L

4. Datais exported.
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Monitor

Connecting/Disconnecting from Ekran System Server

Disconnecting from the Ekran System allows you to change the user. Only users, to which
Administrator or Auditor roles are assigned in the Ekran System Administrative Panel (part of the

Ekran System Server), can connect to the Ekran System Monitor.

To change the user, do the following:
1. Inthe main menu, select File - Change user or press Ctrl + D.

2. The Ekran System Login window opens. Enter the following parameters and click OK:

r 5
E=J localhost - Ekran System Monitor @E‘ﬁ
File View Help
Change user Ctrl+D Q -
Save screen capture... =
F X Results (2 session(s) found ) X
Report L User name | Host name Type Start Last activity Finish
Export video file DEV\afo... Aleks-A-PC Finished 12.02.2013 8:57:36 12.02.2013 8:57:39 12.02.2013 8:57:43
o 2 DEW\afo... Aleks-A-PC Finished 12.02.2013 9:09:58 12.02.2013 9:33:29 12.02.2013 9:33:30
S —=. = = e ‘,;; 09:31:5812/02 Twitter - Mozilla F... firefox.exe
09:32:0212/02 Ekran System Alert  EkranViewerTray.exe
09:32:0212/02 Ekran System Alert  EkranViewerTray.exe
09:32:0312/02 Twitter - MozillaF... firefox.exe
09:32:0812/02 Twitter - MozillaF... firefox.exe
09:32:1312/02 [NO TITLE] explorer.exe
09:32:1412/02 [NO TITLE] explorer.exe
ANANA L 4NN miA TITEm [ SRR SRR, Sy it
X
[7] Show only text characters .
PR« O
00:21:59 / 00:23:30 Number of screen captures: 217
L

e Server: Enter the server name. It can be the IP address, name, or localhost (if the server

is installed on the local computer).

e Login: Enter the login name. It can be <username> if it is the local user and
<domainname\username> if the user is added to the domain.

e Password: Enter the Windows user password.
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r Ekran System Monitor Login lﬁl‘

Server: localhost

Login: |
Password:

OK Cancel

3. The useris changed and connected to the Ekran System.

Viewer Interface

Ekran System Monitor Interface

-
E=] localhost - Ekran System Monitor

File View Help Main menu
Q - Search management area
rHistory X' Results ( 2 session(s) found }
=i Search list User name | Host name Type Start
- :”"Z"t sea'h‘h DEV\afo... Aleks-A-PC Finished  1202.20138:57:36
SRR SLAleles DEWafo... Aleks-A-PC Finished 12.02.2013 9:09:58

History pane

L Activitytime  Activity title

% 09:31:5912/02  Twitter - Mozilla F...
09:32:0212/02 Ekran System Alert
09:32:0212/02 Ekran System Alert
09:32:0312/02 Twitter - Mozilla F...
09:32:08 12/02 Twitter - Mozilla F...
09:32:1312/02 [NO TITLE]
09:32:1412/02 [NO TITLE]

ANANA LAY TRIA TTTE M

[¥] Show only text characters

[ Last activity
12.02.2013 8:57:39
12.02.2013 9:33:29

Results pane

Application name
firefox.exe
EkranViewerTray.exe
EkranViewerTray.exe
firefox.exe
firefox.exe
explorer.exe
explorer.exe

o Ty

Player pane

00:21:59 / 00:23:30

Keystrokes

Finish
12.02.2013 8:57:43
12.02.2013 9:33:30

Number of screen captures: 217

By default, the Ekran System Monitor interface is divided into the following areas:

e The Main menu: Provides you the access to the features of the Ekran System Monitor

program.
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e The Search management area: Allows you to perform quick and parameterized searches.
¢ The History pane: In this pane, the current and favorite searches are displayed.

e The Results pane: In this pane, the detailed results of the search are displayed.

e The Player pane: In this pane, the list of screen captures and the player window are

displayed.

Panes

The Ekran System Monitor interface consists of four main areas:

e Search management area

e History pane
¢ Results pane
e Player pane

Stopped

-
=] Iocalhost - Ekran System Monitor (5 e
File View Help Main menu
Q ~ Search management area
VHistovy X Results 2 session(s) found )} x,
’:\_J Search list User name | Host name Type Start Last activity Finish
o :”":“t sea:h DEW\afo... Finished 12.02.2013 8:57:36 12.02.2013 8:57:39 12.02.2013 8:57:43
i DEV\afo... Finished 12.02.2013 9:09:58 12.02.2013 9:33:29 12.02.2013 9:33:30
History pane Results pane
! Activity time  Activity title Application name Keystrokes =
“, 09:31:5912/02 Twitter - Mozilla F... firefox.exe
09:32:0212/02 Ekran System Alert  EkranViewerTray.exe
09:32:0212/02 Ekran System Alert  EkranViewerTray.exe
09:32:0312/02 Twitter - Mozilla F... firefox.exe
09:32:08 12/02 Twitter - Mozilla F... firefox.exe
09:32:1312/02 [NO TITLE] explorer.exe
09:32:1412/02 [NO TITLE] explorer.exe
ANINA A AN Gl TAIA TTTI MY { o NI Y PR, S R
x|
[¥] Show only text characters Player pane -
PR« A OD-

00:21:59 / 00:23:30

Number of screen captures: 217

The Search management area

This area includes parameters for the search in the Ekran System sessions.

The History pane

In this pane, the Search list tree-view structure is displayed:
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e Current search: This folder contains the parameters and results of the current search.
e Saved searches: This folder contains the saved user search parameters.

The Results pane

In this pane, the search results are displayed. The search results fields are filled when the search
finishes. The results are displayed in a grid with the following columns:

e User name: The name of the Ekran System user.

¢ Host name: The name of the computer on which the Client is installed.
o Type: The search type. It can be Finished, Live, and Non-Licensed.

e Start: The date when the session started.

o Last activity: The date of the last made screen capture.

o Finish: The date when the session finished. If the session has the Live status, this field is
empty.

The Player pane

The Player pane is divided into two areas: the list of screen captures (to the right) and the player
itself (to the left).

The list of screen captures is displayed in a grid with the following columns:

e Alerticon: Indication, whether the screen capture belongs to alert type.

o Activity time: The date and time when the screen capture was made.

e Activity title: The name that is associated with the screen capture.

¢ Application name: The name of the application that was started on the Client computer.

o Keystrokes: The content of the keystrokes log associated with the selected screenshot.
NOTE: The keystrokes are not logged in a virtual machine session. To log keystrokes from
a virtual machine session, you need to install a Client on the virtual machine.

You can change the size of the columns. Data is sorted by the time of the screen capture creation.

Main Menu

The main menu of the Ekran System Monitor provides the access to the features of the program.
The main menu consists of three parts:

e File menu

e View menu

e Help menu

File menu
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_
localhost - Ekran System Monitor

\Flle View Help
Change user Ctrl=D Q -

= Save screen capture... — _
k X Results ( 2 session(s) found |

Export video file \ Session activity report

Exit

The File menu consists of four options:

e Change user: Allows you to change the Ekran System Monitor user.

¢ Save screen capture: Allows you to save the screen capture selected in the Player area.
¢ Report: Allows you to generate two types of reports.

o Export video file: Allows you to export the screen captures from the session to a video file
format.

o Exit: Allows you to exit the Ekran System Monitor.

When disconnecting from the Ekran System Server, the Ekran System Login window opens. Fill
the Login and Password boxes and click OK to connect to the Ekran System Server.

r Ekran System Monitor Login @w
Server: localhost
Login: |
Password:

View menu

File §7View7 Help
V\V-v— History

77777 (7 Results
HISOY [, piayer

Bu \ v Keystrokes

{_j Saved searches
The View menu consists of four options that allows you to enable/disable panes:
e History: Allows you to enable/disable the History pane.
e Results: Allows you to enable/disable the Results pane.
e Player: Allows you to enable/disable the Player pane.
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e Keystrokes: Allows you to enable/disable the Keystrokes box in the Player pane.

Help menu

File Wiew | Help

About...

History
The Help menu consists of two options:
e Help: Provides you the access to this help file.
e About: Provides you with information about the Ekran System Monitor application.

Search

About Searching

You can perform searches in the Ekran System sessions. Each session contains a set of screen
captures made from the investigated computer during the specified period of time. You can
search by the following parameters: name of the screen capture, the application name, user,
name of the computer with installed Client, date of the session start, date of the session finish,
date of the last made screen capture, and type of the session.

There are two types of searching:
e Quick: Allows you to perform searching by the text data.
¢ Parameterized: Allows you to perform searching using multiple parameters.

Quick Search

The quick search allows the user to perform searches by the text data, i.e. by the name of the
application, the screen capture title, user name, host name, and the type of the session.

The quick search is enabled by default.

To perform a quick search, do the following:
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1. In the Search management area (under the Main menu), click on the arrow near the
Search button and select Quick search.

"
[=] void - Ekran System Monitor SRICE X
File View Help
- Q4 ouicksearn |
Histary X Results (0 5 X
. - Parameterized search
E\"L-:tr Search list User name - Type Start Last activity Finish

In the Search box, enter the required data by which you want to perform searching.
Click on the Search button or press Enter.

The search starts.

When the search finishes, the results are displayed in the Results pane.

o v AwWN

Parameterized Search

Click the session in the Results pane to view the detailed information in the Player pane.

The parameterized search allows the user to perform searching in the Ekran System sessions using

multiple parameters.

To perform a parameterized search, do the following:

1. Inthe Search management area (under the Main menu), click on the arrow near the Search
button and select Parameterized search.

=] void - Ekran System Monitar

File View Help

: v  Quick search
History ¥ Results (0 5

= Search list — Parameterized search

2. The parameterized search area opens.

Application name
Alert name

Keystrokes

3. By default, there is only one search condition. To add another condition, click on the plus
button. The new condition line will be displayed below the first one.

r ~
E=J localhost - Ekran System Monitor l&@l&]
File View Help
User name ~ equalto ¥ J\, v W L
User name 7]
Hi Host name Results ( 2 session(s) found )
~Type T T
= Start time User name | Host name Type Start Last activity Finish
Last activity time = 3 2
Finish time DEW\afo... Aleks-A-PC Finished 12.02.2013 8:57:36 12.02.2013 8:57:39 12.02.2013 8:57:43
Activity title DEW\afo... Aleks-A-PC Finished 12.02.2013 9:09:58 12.02.2013 9:33:29 12.02.2013 9:33:30

106



[=] EKRAN SYSTEM

NOTE: Search conditions on data of one type are combined with OR logic. Search
conditions on data of different types are combined with AND logic.

Define the search parameters.

5. When adding the Start, Finish time, or Last Activity time condition, the Now option is
available. Select this option to perform the search till the current computer date.

E=] localhost - Ekran System Monitor lﬂ‘_—it_h_J
File View Help ‘
User name v equalto ~ admin )\ > 4
Host name v like ~ PC g =
Last activity time ~ equalto v 12,02.2013 B~ [(INow o =

Click on the Search button or press Enter.

7. The search starts. When the process of searching finishes, the results are displayed in the
Results pane.

Parameterized Search Parameters

The parameterized search condition consists of the Parameter box, Comparison operator box,
and the Value box.

You can add up to 10 conditions. To add the condition, click the plus icon. To delete the
condition, click on the minus icon. The conditions of different types are connected with "AND"
logic, it means that each specified condition will be TRUE for each found session in the Results
pane. The conditions of the same type are connected with “OR” logic, it means that at least one of
the specified conditions of the same type will be TRUE for each found session in the Results pane.

Text data parameters

Search Iltem Description Example

User name The name of the Windows user whose work John
is monitored by Ekran System.

Host name The name of the computer on which the Kenny
Client is installed.

Type The type of the session. The following types Finished, Live
are available: Finished (the session is

finished), Live (the session is running), Non-
Licensed (the computer with the Client has
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no license).

Title The name associated with the screen Start menu
capture. It associates with the currently
opened window on the investigated
computer, context menu, etc.

Application The name of the started application on the explorer.exe
investigated computer.

Alert name The name of the alert that occurred on the Facebook
investigated computer. alert
Keystrokes A phrase or a word that was logged on the Corporate
investigated computer. security
breach

Comparison operators for text data:

e equal to: the defined value fully corresponds to the found result (e.g., John will find John,
but will not find Johny);

o like: the found result includes the defined value (e.g., John will find Johny, Johnatan, but
will not find Johan);

Date parameters

Search Item Comparison Operator Example
Start time The date of the session start. 9/13/2010
Last The date of the last made 12/13/2009
Activity screen capture.

time

Finish time The date of the session 12/12/2008
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| ‘ finish. ‘ |

Additional options:
e Now: Select this option to enable the searching till the current date.

Comparison operators for dates:

e equal to: the specified date fully corresponds to the found result (e.g., 12/12/2009 will
find 12/12/2009 but will not find 12/11/2009);

e before: the found results will match all the dates till the specified one (e.g., 12/12/2009
will find 07/08/2009 but will not find 12/12/2010);

o after: the found results will match all dates after the specified one (e.g., 12/12/2009 will
find 12/12/2010 but will not find 12/12/2008).

Saving Search Parameters

You can save the search parameters to make it easier to perform further searches. The search
parameters will be saved in the Saved searches folder in the History pane. The saving of search
parameters is available only for the parameterized search.

To save the search parameters, do the following:
1. Define the search parameters.
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4 = > ~N
{=] localhost - Ekran System Monitor @Elg
' File View Help

User name v equalto v John Q\ v qﬂ(‘— oh
Application name v equalto v explorer.exe gp =
History X Results 2 session(s) found ) X
E‘{j‘ Search list User name | Host name Type Start { Last activity
...’ Current search ' e :
el G s ¥ DEWV\afo... Aleks-A-PC Finished 12.02.2013 8:57:36 12.02.2013 8:57:39
""" iy SOVEASEAIENES | DEV\afo... Aleks-A-PC Finished 12.02.2013 9:09:58 12.02.20139:33:29
IS 1] | »
L Activitytime  Activity title Application name Keystrokes

X |

i

> B|«» «»| Y-
Stopped

Number of screen captures: 217
2. Click on the Save search icon.
3. The Saved Search window opens.
4,

Enter the name for the set of the search parameters and click OK.

7 ST
Saved Search E

Searchname: My search|

[ ok ][ concel |

5. The search parameters are added to the Saved searches folder. You can view it in the History
pane.
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5 | |
=] localhost - Ekran System Monitor E‘_li_hj
' File View Help
User name v equalto v John Q\ v q/f oh
Application name v equalto v explorer.exe gp =
History X Results (2 session(s) found ) X
L:’L—J‘ ?earch list ’ User name | Host name N‘Type | Start ! Last activity
o g”":"t Sea’h‘h DEW\afo... Aleks-A-PC Finished 12.02.2013 8:57:36 12.02.2013 8:57:39
- S ST DEW\afo... Aleks-A-PC Finished 12.02.2013 9:09:58 12.02.2013 9:33:29
vl My search
1 | »
L Activitytime  Activity title Application name Keystrokes
£ 1l »
| x |
[# Show only text characters
> B|«» «»| Y-
‘ Stopped 00:21:59 / 00:23:30 Number of screen captures: 217

NOTE: When opening search parameters that include dates (Finish time, Start, or Last activity
time) with enabled Now option, the date will be set as the current one.

Restoring Search Parameters

You can restore the saved search parameters. This makes it easier to perform further searches

without defining the same parameters again.

To restore the search parameters, do the following:

1. Inthe History pane, navigate to the Saved searches folder in the Search list tree.
2. Inthe Saved searches folder, select the required folder with saved search parameters.
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= X N
=] localhost - Ekran System Monitor E@Iﬂ
' File View Help

User name v equalto v John Q\ v if oh
Application name v equalto v explorer.exe o
History Xﬁ" Results { 2 session(s) found ) X
E‘{J Search list User name | Host name Type | start { Last activity
.../ Current search ' T ‘
s DEW\afo... Aleks-A-PC Finished 12.02.2013 8:57:36 12,02.2013 8:57:39
=i Saved searches A
2 DEW\afo... Aleks-A-PC Finished 12.02.2013 9:09:58 12,02.2013 9:33:29
|| €] 1 | b
L Activitytime  Activity title Application name Keystrokes
< | 1 »
i X
[# Show only text characters
> E|«» «»| Y-
Stopped 00:21:59 / 00:23:3 Number of screen captures: 217

3. The saved search parameters are displayed in the Search management area.

4. Click on the search button or press Enter to start searching.

Examples of Search Parameters

1. To find all screen captures connected with the work of explorer.exe, enter the following

parameters:

-
= localhost - Ekran System Monitor

o . i
File View Help
' Application name ~ equalto ~ | explorer.exe| Q -5 4
2. To find all finished Ekran System sessions, enter the following parameters:
TS i - B Syt Ncor ESRECE™ >
File View Help
Type v equal to ~ | Finished| Q -3¢ 4k
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3. Tofind all sessions started on February 12, 2010 and finished on February 13, 2010,
enter the following parameters:

7 T ~
=] localhost - Ekran System Monitor | |ulE] &l

File View Help

Start time ~ equalto v 12.02.2013 B~ FNow Q -5 4

Finish time v equalto v 112.02E0E B~ [INow dp =

4. To find all sessions connected with Facebook, enter the following parameters:
r | 5
=] localhost - Ekran System Monitor =REE X

File View Help ‘

Activity title v like v |facebook \)\ v W gk

5. To find all sessions connected with the discussion of corporate policy, enter the
following parameters:

=] localhost - Ekran System Monitor I =(u(E lﬁ

File View Help ’

Keystrokes v equalto ~ corporate policy J\ L ¢ C ]

Viewing Monitored Data

Viewing Screen Captures

The Ekran System Monitor allows you to view the screen captures made from the computer on
which the Client is installed. You can view them separately by selecting the required screen
capture from the list or viewing all screen captures in the form of video.

To view the screen captures, do the following:
In the Results pane, select the required session.

The list of all screen captures from the session are displayed in the form of grid in the right
part of the Player pane.
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(=] localhost - Ekran System Monitor == i&l

File View Help

Keystrokes v equalto v corporate policy J\ - ’,\: 4P
History X Results { 2 session(s) found ) x,
E-aF Search list User name | Host name | Type | Start Last activity Fin
o g”"‘;’“ Se""h‘h DEW\afo... Aleks-A-PC Finished 12.02.2013 8:57:36 12.02.2013 8:57:39 12,
e L DEV\afo.. Aleks-A-PC Finished 12.02.2013 9:09:58 12.02.2013 9:33:29 12
7 My search -
Selected session
< i | »

! Activity time  Activity title Application name

09:11:4912/02 RoboHelp HTML - Corporate_Security_... dwm.exe
09:11:5312/02 RoboHelp HTML - Corporate_Security_... dwm.exe

09:11:5812/02 [NO TITLE] explorer.exe
09:11:58 12/02 [NO TITLE] List of EkranViewerTray.exe
09:12:0012/02 [NO TITLE] screencaptures EkranViewerTray.exe
09:12:0012/02 [NO TITLE] EkranViewerTray.exe
109:12:1012/02  [NO TITLE] EkranViewerTray.exe ~
<[ I | »

[¥] Show only text characters

[T RTINS R

Stopped 00:00:00 / 00:23: Number of screen captures: 217

3. The Player is not playing by default. Do one of the following:

e Inthe list of screen captures, select the required screen capture. It is displayed in the
Player area.

e Inthe list of screen captures, select the screen capture starting from which you want
the video to be streamed. In the Player area, click Play. Screen captures are displayed
in order one by one.

To pause/stop the video, use the corresponding Pause and Stop control buttons in the Player
area.

To move from one screen capture to the next one, use the Previous/Next control buttons.
To move to the full-screen mode, double click the screen capture in the Player area.

You can define the speed with which screen captures will change in the Player area. To do this,
click Video speed and in the drop-down list, select Actual to change screen captures depending
on the screen capture creation time; select 1 fps to display one screen capture per second.

If the search conditions included the Title and Application items, the additional control buttons
are displayed in the Player area. They are marked blue and allow moving between the found
search results.
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r T
(=] localhost - Ekran System Monitor == &I

File View Help

Application name v equalto v explorer.exe J\, A4 ’,\: ap
History X Results {1 session(s) found) X
E-aF Search list User name | Host name Type Start | Last activity Fin
| Slment sedich DEW\afo... Aleks-A-PC Finished 12.02.2013 9:09:58 12.02.2013 9:33:29 124
[=-iF Saved searches
37 My search
[ " | r
! Activity time  Activity title Application name ~ “
09:13:2012/02 Mozilla Firefox firefox.exe
09:13:27 12/02 [NO TITLE I K
> [ ! Found results SECERE
09:13:2912/02 [NO TITLE] explorer.exe

09:13:4412/02 Ekran System Alert - Facebook alert - A...  EkranMonitor.exe
09:13:5112/02 Ekran System Alert - Facebook alert - A... EkranMonitor.exe
09:14:0212/02 Ekran System Alert - Facebook alert - A...  EkranMonitor.exe

1 09:14:1612/02  Ekran System Alert - Facebook alert - A...  EkranMonitor.exe Y
< | 1 | »

[¥] Show only text characters

[T RTINS R

Stopped 00:00:00 / 00:23: Number of screen captures: 217

|

When you select a screen capture, the keystrokes associated with it are displayed in the box,
below the list of screen captures. By default it displays only text characters, you can enable
displaying all keystrokes logged (e.g. navigation kesy, functions keys, etc.) by clearing the Show
only text characters checkbox. Then any other keys and key combinations will be displayed in
inequality sign brackets. If a key was pressed repeatedly it will be displayed with an "x" sign and
the number of reiterations (e.g. <F12 x 24>).

Please note that keystrokes are not logged from virtual machines.

NOTE: If the Enter key was pressed during input, the log will be split in the list of screen
captures. Though to maintain text integrity, in the keystrokes box, the keystrokes lines having
the same Title-Application pair will be put together.

Viewing Live Sessions

Ekran System Monitor allows you to view screen captures in a Live session (i.e., the monitoring of
the Client computer is still in progress).

If the session has the Live status, the list of screen captures is refreshed each second and new
screen captures are added to the table if any are available.
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For Live sessions, the additional button is available in the Player area. When you click this button,
the real-time monitoring is performed. This means that screen captures appear in the Player area
the moment the activity was performed on the investigated computer.

NOTE: If you click this button, you will not be able to navigate between screen captures in the

list.

Receiving Information on Alert Events

The investigator can receive information on Alert events in three ways:

e In the Monitor application, when the investigator browses the screen captures. The alert

events are marked with a special icon.

If email notifications are enabled in the Alert Parameters, the alert information can be
received in the email alert notification that also contains the link for viewing this alert in
the Ekran System Monitor.

NOTE: You need the Monitor to be properly installed in order to activate links in the email

notifications.
If the tray notifications are enabled in the Alert Parameters, the information can be
displayed by clicking the View in the Ekran System Monitor link in the pop-up notification
from the Monitor Tray. Or this information can be received from the Tray Notifications

Journal called from the Monitor Tray context menu.

-
=] Ekran System Alert - Facebook alert - Aleks-A-PC

=] B ) |

P IR« Mme-

+  Activity time

09:12:3212/02
09:12:3912/02
09:12:4112/02
09:12:4212/02
09:12:4912/02

1 09:13:0212/02 | Welcome to Facebook - Log In, ...

09:13:0212/02
09:13:0912/02
09:13:1412/02
09:13:20 12/02
09:13:2712/02
09:13:2912/02

Activity title

Ekran System Administrative Pa...

Applicationr *
mmc.exe

Ekran System Administrative Pa... mmc.exe
Ekran System Administrative Pa... mmc.exe
Ekran System Administrative Pa... mmc.exe

Ekran System Administrative Pa... mmc.exe

Welcome to Facebook - LogIn, ... firefox.exe
Welcome to Facebock - LogIn, ... firefox.exe
Mozilla Firefox firefox.exe
Moezilla Firefox firefox.exe !=
[NO TITLE] explorer.exe |
[NO TITLE] explorer.exe ~

[#] Show only text characters

L 13

Number of screen captures: 5¢
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Reports

About Reports

The user can generate a report to export search results to a separate file. The report is
generated in the *.xls format.

The following two types of reports are available:
e Search Results report: This type of report includes information on all found sessions.
The following data is included: number of found sessions, search type, date of the

report generation, types of sessions, host names, activity time, and number of screen
captures. Report can also include detailed information on each found session.

e Session Activity report: This type of report includes information on the user activity in
one or more sessions.

Search Results Report

Search Results report includes information on all found sessions. The following information is
included to the report: date of report generation, path to the report, type of the search, number
of found sessions, types of sessions (live or finished), names of the investigated computers, activity
time, etc. If the user used parameterized search, search parameters and their values are also
included to the report.

The report can also include detailed information for each found session. Information on each
session is displayed in a separate tab named <number>Session. It includes general information on
the session and the table with the names of screen captures and their creation date and time as it
is displayed in the list of screen captures in the Player pane.

To generate the Search Results report, do the following:

1. Inthe main menu, select File - Report - Search Results Report or right click the session in
the Results pane and select Report - Search Results Report.

NOTE: The report can be generated for more than one session. Multi-selection is available in
the Results pane.

2. The Search Results Report window opens.
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[ Search Results Report &Jq

Options
Open generated report
Add detailed information for each session

Location
Fath:

D:\Test dataSearch results report. xls

l Generate I I Cancel I

L

3. Inthe Options, select the required options. The following options are available:

e Open generated report: Select this option to automatically open the report after
the generation process finishes.

e Add detailed information for each session: Select this option to include detailed
information for each session to the report.

4. In the Path box, do one of the following:
e Enter the path to the generated report manually.

e Click Browse and define the location for the file with generated report.
5. Click Generate to generate the report.

When the generation process finishes, click Finish. The report will open automatically if
the corresponding option was selected.

Session Activity Report

The Session Activity report includes general information on the user activity in the session
currently opened in the Player pane. Also, detailed information on the session activity is displayed
in a separate tab named <hostname><date and time of the session start>.

NOTE: The user can use Ctrl and Shift keys to select more than one session in the Results pane. In
this case, report will include detailed information on each selected session.

To generate the Session Activity report, do the following:
1. Inthe results pane, select one or several sessions.
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2. Inthe main menu, select File - Report - Session Activity Report or right-click the session

and select Report - Session activity report.

=] localhost - Ekran System Monitor

[ <]

Export video file Session activity report

Search results report

= [ =
File View Help
Q -

X Results (3 session(s) found ). X

‘ User name ‘ Host name Type ‘ Start Last activity ‘ Fini

IR DEW\afo.. Aleks-A-PC Finished 27.12.201211:18:43 27.12.201211:23:38 271
- Seved sesrches DEW\afo... Aleks-A-PC Finished 2712.2012 11:24:17 27.12.201211:27:29 271

Aleks-p=- - " ; 27122012 13:18:30

3. The Session Activity Report window opens.

-

Session Activity Report

Options
Open generated report
Add detailed information for each session

Location

Path:

D:\Test data\Session activity report, xls

Browse...

I Generate l [ Cancel

)

b

4. Select the Open generated report option to automatically open the report after the

generation process finishes.
5. Inthe Path box, do one of the following:
e Enter the path to the generated report manually.

e Click Browse and define the location for the file with generated report.

6. Click Generate to generate the report.

7. When the generation process finishes, click Finish. The report will open automatically if

the corresponding option was selected.
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Exporting Video

Exporting video means exporting screen captures of the session in the video format to your
computer. Video is exported in the *.avi format. Video resolution will be the same as the
resolution of screen captures received from the Client computer.

To export video, do the following:

Results pane and select Export video file.

Select the target session in the Results pane. Then do one of the following:

Select File - Export Video File from the main menu or right click the session in the

B localhost - Ekran System Monitor

= | E

File View Help

History

=7 Search list
{7 Current search
G-l Saved searches

“‘

{ \)\ 2
X Results (3 session(s] found) x
User name Host name Type ‘ Start ‘ Last activity Fini
. Aleks-A-PC Finished 2712.201211:18:43 2712.201211:23:38
DEW\afo... Aleks-A-P Report » §27.12.201211:24:17 27.12.2012 11:27:29 271
DEW\afo... AIeks-A-P 27.12.201213:18:22 27.12.201213:18:30 N/A

11

| »

select Export video file.

Select one or more captures in the Player Management pane, right click them and
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7
localhost - Ekran System Monitor = | =
Y

File View Help

\l‘ Z
History X ‘ iResutts (3 session(s) found ) X
Bt_’i :S‘eafCAh list I ‘ Host name TType j.Start Last activity \ Einl
il Curént seaich DEV\afo.. Aleks-A-PC Finished  27.12.201211:18:43 2712.201211:23:38 271
R S ec sesiches DEW\afo.. Aleks-A-PC Finished 2712.201211:24:17 27.12.201211:27:29 271
DEW\afo... Aleks-A-PC Live 27.12.201213:18:22 27.12.201213:18:30 N/

. w 0

L Activity time  Activity title Application nar #

L ———
- 11:20:00 27/12 St gt icea i explorer.exe ' —
11:20:00 27/12 [NO TITLE] explorer.exe
11:20:00 27/12 Start menu explorer.exe
11:20:00 27/12 Start menu explorer.exe
11:20:04 27/12 Start menu explorer.exe -
> < | " »

T BRI TSR R

Stopped 0:01:12 / 00:04:54 Number of screen captures: 118

NOTE: You can export the whole session as well as a part of it. To select screen captures for
exporting, use Ctrl and Shift keys.

2. The Export Video window opens.

Export Video lg

Export options
Video codecs are required for video creation.

Video codec: | mpEaElen a0 « | | Configure...

Screen capture displaying period

(@ Seconds per 1 screen caplure: 2

() Original

Export to:

D:'Test data}17.03.2011 11_02_07.avi

Expart video ] [ Cancel ]
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3.

In the Video codec drop-down list, select the required codecs with the help of which
video will be created. Please note that the list contains only the system codecs that will
be used for video creation.

Click Configure to configure the selected codec. Configuration window depends on the
selected codec.

In the Screen capture displaying period group of options, select the speed with which
video will play. The following options are available:

e Real: Video will play with a real speed depending on the frequency of created
screen captures.

e Custom: Define the time interval in seconds with which screen captures will change
in the video file.

In the Export to box, do one of the following:
e Enter the path to the video file manually.
o Click Browse and navigate to the location fro the exported video file.
Click Export video to export the session.
When the export process finishes, click Finish.
Navigate to the folder with exported data.

NOTE: If there was a change of resolution on the Client computer display or change of bit

depth, several video files can be exported.

Saving Screen Captures

You can save the required screen capture to a file on your computer. Screen captures are saved

in the *.png format.

To save the screen capture, do the following:
1. Inthe Player pane, in the list of screen captures, select the required screen capture.
2. ltis displayed in the Player window.

3. Right click the screen capture and select Save screen capture or in the main menu,
select File - Save screen capture.
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|
=] localhost - Ekran System Monitor

i

=B
File View Help
Q -~
History X" .Resutts (3 session(s) found ) b4
EH—? ?earch list || User name ‘ Host name : Type | Start ‘ Last activity ‘ Fini
- E”"e"‘ Sea;‘h DEV\afo... Aleks-A-PC Finished 2712.201211:18:43 2712.201211:23:38 271
e Sverl semrches DEV\afo... Aleks-A-PC Finished 27.12.201211:24:17 2712.201211:27:29 273
DEWV\afo... Aleks-A-PC Live 2712.201213:18:22 27.12.201213:18:30 N/4
1] J »
L Activity time  Activity title Application nar *
11:19:56 27/12 [NO TITLE] explorer.exe 3
11:20:00 27/12 Start menu explorer.exe —
11:20:00 27/12 [NO TITLE] explorer.exe
11:20:00 27/12 Start menu explorer.exe
11:20:00 27/12  Start menu explorer.exe
11:20:04 27/12 Start menu explorer.exe

mr

>

Number of screen captures

4. In the Save As window, define the name and location for the screen capture. Click

Save.

1118
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i /4 Save As ﬂ

Savein: [ Libraries - 02 2 Er
,L - ;*v
oy - &|  Documents = Music
e < ——Fp Library - Library
Recent Places - 7 :
-, m Pictures p=. Subversion
J : Mgy Library <=, Library
Desktop o 73 =

‘ Videos
e Library

Libraries

i
Computer
“
Network
File name: ser| v Save
Save as type: [PNG Files (".png) ']

5. The screen capture is saved.
6. Navigate to the folder with screen capture.

NOTE: You cannot save the screen capture if the video is playing or if there is a full-screen
mode.
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